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Computer - 1

CHAPTER-1
Computer : A Friendly 
Machine & Its Uses

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (b)
	 3.	 (b)	 4.	 (b)
	 5.	 (a)
B.	 Fill in the blanks:
	 1.	 digital	 2.	 computer
	 3.	 tired	 4.	 Computer
	 5.	 tablet
C.	 True/False:
	 1.	 T	 2.	 T
	 3.	 F	 4.	 T
	 5.	 F
D.	 Complete the following sentences:
	 1.	 electricity
	 2.	 fast
	 3.	 tasks
	 4.	 commands
	 5.	 tired
	 6.	 informations
Art Integration
	 Do yourself.

CHAPTER-2
Parts of Computer

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (a)
	 3.	 (b)	 4.	 (a)
	 5.	 (b)
B.	 Fill in the blanks:
	 1.	 music	 2.	 keys
	 3.	 Mouse	 4.	 Central
	 5.	 CPU

C.	 Match the computer part with its 
function:

	 1.	 c	 2.	 e
	 3.	 a	 4.	 b
	 5.	 d
D.	 True/False:
	 1.	 F	 2.	 T
	 3.	 F	 4.	 F
	 5.	 T
E.	 Identify the parts of the computer and 

write their names.
	 1.	 Monitor	 2.	 Keyboard
	 3.	 Mouse	 4.	 CPU
	 5.	 Printer	 6.	 Speakers
Art Integration
	 Do yourself.

CHAPTER-3
Monitor and CPU : 

Computer's Best Friends

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (b)
	 3.	 (b)	 4.	 (a)
B.	 Fill in the blanks:
	 1.	 drawings	 2.	 brain
	 3.	 movies	 4.	 together
	 5.	 distance
C.	 True/False:
	 1.	 T	 2.	 T
	 3.	 F	 4.	 F
	 5.	 T
D.	 Match the Columns:
	 1.	 c	 2.	 e	 3.	 d
	 4.	 b	 5.	 a
Art Integration
	 Do yourself
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CHAPTER-4
Fun with Mouse

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (b)
	 3.	 (a)	 4.	 (b)
	 5.	 (a)
B.	 Fill in the blanks:
	 1.	 cable	 2.	 pointer
	 3.	 pad
	 4.	 Scroll wheel
	 5.	 index
C.	 True/False:
	 1.	 F	 2.	 F	 3.	 T
	 4.	 F	 5.	 F
D.	 Match the following:
	 1.	 b	 2.	 d
	 3.	 a	 4.	 e
	 5.	 c
Art Integration
	 Left Mouse Button
	 Scroll Wheel
	 Right Mouse Button
	 Mouse tail or cable

CHAPTER-5
Fun with Keyboard

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (a)
	 3.	 (a)	 4.	 (a)
	 5.	 (b)
B.	 Fill in the blanks:
	 1.	 Down	 2.	 Caps Lock
	 3.	 enter	 4.	 numbers
	 5.	 Backspace
C.	 True/False:
	 1.	 F	 2.	 T
	 3.	 T	 4.	 F
	 5.	 T

D.	 Match the Columns:
	 1.	 d	 2.	 e
	 3.	 a	 4.	 b
	 5.	 c
Art Integration
	 Do yourself.

CHAPTER-6
Paint

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (b)
	 3.	 (b)	 4.	 (a)
	 5.	 (b)
B.	 Fill in the blanks:
	 1.	 fill
	 2.	 shapes
	 3.	 eraser
	 4.	 drawing area
	 5.	 line
C.	 True/False:
	 1.	 F	 2.	 T
	 3.	 T	 4.	 F
	 5.	 T
D.	 Match the Columns:
	 1.	 c	 2.	 d	 3.	 e
	 4.	 b	 5.	 a
Art Integration
	 Do yourself.

CHAPTER-7
TUX Paint

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)
	 3.	 (b)	 4.	 (b)
	 5.	 (b)
B.	 Fill in the blanks:
	 1.	 toolbar	 2.	 save
	 3.	 hidden	 4.	 colour
	 5.	 canvas
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C.	 True/False:
	 1.	 T	 2.	 T
	 3.	 F	 4.	 T
	 5.	 F
D.	 Match the Columns:
	 1.	 b	 2.	 e
	 3.	 a	 4.	 c
	 5.	 d
Art Integration
	 Do yourself.

CHAPTER-8
Drawing with AI

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (b)
	 3.	 (a)	 4.	 (a)
	 5.	 (a)
B.	 Fill in the blanks:
	 1.	 create
	 2.	 AI
	 3.	 colour
	 4.	 suggestions
	 5.	 Artificial
C.	 True/False:
	 1.	 T	 2.	 T
	 3.	 F	 4.	 F
	 5.	 T
D.	 Match the Columns:
	 1.	 b	 2.	 c	 3.	 a
	 4.	 d	 5.	 e
Art Integration
	 Do yourself.

CHAPTER-9
Do's and Don'ts of Computer

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)
	 3.	 (a)	 4.	 (a)
	 5.	 (a)

B.	 Fill in the blanks:
	 1.	 queue
	 2.	 silence
	 3.	 electrical
	 4.	 drink, eat
	 5.	 cover
C.	 True/False:
	 1.	 T	 2.	 F
	 3.	 T	 4.	 F
	 5.	 T
D.	 Answer the questions given below:
	 1.	 To keep it dust free, neat and clean.
	 2.	 No, we should not make noise in a 

computer room.
	 3.	 To keep our computer clean, we 

should always keep it covered.
Art Integration

Rule Chart
	 (a) � Remove your shoes before entering 

a computer room.
	 (b) � Maintain a queue to enter the 

computer room.
	 (c) � Always keep silence inside the 

computer room.
	 (d) � Computer should be kept dust free, 

neat and clean.
	 (e) � Computer should always be 

switched off, when not in use.
	 (f) � Do not press computer keys roughly.

Worksheet - 1
A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (b)
	 3.	 (b)	 4.	 (a)
B.	 Fill in the blanks:
	 1.	 digital	 2.	 Central
	 3.	 pad	 4.	 enter
C.	 True/False:
	 1.	 F	 2.	 F
	 3.	 F	 4.	 F



5Teachers' Manual

D.	 Identify the parts of the computer and 
write their names.

	 1.	 Monitor
	 2.	 CPU
	 5.	 Printer

Worksheet - 2
A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)
	 3.	 (a)	 4.	 (a)

B.	 Fill in the blanks:
	 1.	 shape
	 2.	 toolbar
	 3.	 suggestions
	 4.	 electrical
	 5.	 Artificial
C.	 Match the Column:
	 1.	 b	 2.	 e
	 3.	 a	 4.	 c
	 5.	 d


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Computer - 2

CHAPTER-1
Working of a Computer

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (c)
	 3.	 (b)	 4.	 (c)
	 5.	 (c)
B.	 Fill in the blanks:
	 1.	 mouse	 2.	 printer
	 3.	 CPU	 4.	 scanner
	 5.	 pendrive
C.	 True/False:
	 1.	 F	 2.	 F	 3.	 T
	 4.	 F	 5.	 T
D.	 Match the following:
	 1.	 c	 2.	 a
	 3.	 d	 4.	 b
E.	 Answer the following questions:
	 1.	 A computer is an electronic device.
	 2.	 Any machine or part which performs 

a task is called device.
	 3.	 The name of three input devices are : 

Keyboard, Scanner and Mouse.
	 4.	 The name of three output devices are 

: Monitor, Printer and Speakers.
Art Integration
	 Do yourself.

CHAPTER-2
Computer in Our Daily Life

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)
	 3.	 (c)	 4.	 (c)
	 5.	 (c)
B.	 Fill in the blanks:
	 1.	 buildings
	 2.	 banks

	 3.	 home
	 4.	 sattellites, rockets and missiles.
	 5.	 printings
C.	 True/False:
	 1.	 T	 2.	 F	 3.	 F
	 4.	 T	 5.	 T
D.	 Match the following pictures with 

their activity.
	 1.	 Studying
	 2.	 Billing counters at shops
	 3.	 Scientific researches
	 4.	 Online shopping
E.	 Answer the following questions:
	 1.	 Computers are used in the school 

library, to keep the records of books.
	 2.	 (1) It helps in checkups and eye 

testing. (2) It helps a doctor in 
operations.

	 3.	 ATM helps us to withdraw the 
money.

	 4.	 Computers helps in reservation 
and cancellations of tickets for 
passengers.

	 5.	 Computer help engineers in 
designing cars, airplanes and other 
useful machines.

Art Integration
	 Do yourself.

CHAPTER-3
Working with Windows

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (b)
	 3.	 (c)	 4.	 (a)
	 5.	 (b)
B.	 Fill in the blanks:
	 1.	 UPS
	 2.	 gently
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	 3.	 eyes
	 4.	 long
	 5.	 short
C.	 True/False:
	 1.	 T	 2.	 F
	 3.	 F	 4.	 T
	 5.	 T
D.	 Answer the following questions:
	 1.	 UPS prevents computer from sudden 

shutdown if power goes off.
	 2.	 (1) Keep the computer safe from dust 

by covering it, when not in use. (2) 
Clean the computer with a clean, soft 
and dry cloth.

	 3.	 (1) Never eat or dring while working 
on a computer. (2) Never play with 
the connections and wires of the 
computer.

	 4.	 The first display screen, you get 
when the computer is switched on is 
known as window desktop.

Art Integration
	 Do yourself

CHAPTER-4
Notepad

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (a)
	 3.	 (b)	 4.	 (b)
	 5.	 (c)
B.	 Fill in the blanks:
	 1.	 cursor
	 2.	 keyboard
	 3.	 editing

	 4.	 character
	 5.	 .txt
C.	 True/False:
	 1.	 F	 2.	 F
	 3.	 T	 4.	 T
	 5.	 F
D.	 Write the steps to start the notepad in 

the correct order.
  Step 1 : Click on the start Button.
  Step 2 : Go to Window Accessories.
  Step 3 : Click on Notepad.
E.	 Answer the following questions:
	 1.	 Notepad is the software that is used 

for typing text on the computer.
	 2.	 The text starts to appear form the 

position of the cursor.
	 3.	 Yes, we can write our name in 

Notepad.
	 4.	 No, we cannot draw a picture in 

Notepad. It is only for typing text.
Art Integration
	 Do yourself

CHAPTER-5
Wordpad

A.	 Tick (3) the correct answer:
	 1.	 (c)	 2.	 (c)
	 3.	 (a)	 4.	 (b)
	 5.	 (c)
B.	 True/False:
	 1.	 T	 2.	 F
	 3.	 T	 4.	 T
	 5.	 T
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C.	 Name the following with the help of given word in the box.

D.	 Fill the missing letters in the given 
word.

	 1.	 Font	 2.	 Ribbon
	 3.	 Cursor	 4.	 Underline
	 5.	 Italic
E.	 Answer the following questions:
	 1.	 Wordpad is a program that is used 

for typing text on a computer.
	 2.	 (a) To select a single word, double 

click on it.
		  (b) To select a line, click and drag the 

mouse over it.
		  (c) To select all text press ctrl+A.
	 3.	 Method 1– By clicking the close (7) 

button form the top right hand side 
of wordpad window.

		  Method 2– By clicking the close 
option form the wordpad menu.

Art Integration
	 Do yourself.

CHAPTER-6
Fun with TUX Typing

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (c)
	 3.	 (a)	 4.	 (a)
	 5.	 (a)
B.	 Fill in the blanks:
	 1.	 typing	 2.	 fish
	 3.	 keyboard	 4.	 sky
	 5.	 computer

C.	 True/False:
	 1.	 T	 2.	 F
	 3.	 T	 4.	 F
	 5.	 T
D.	 Match the following:
	 1.	 b	 2.	 d
	 3.	 c	 4.	 a
E.	 Answer the following questions:
	 1.	 The name of the penguin is TUX.
	 2.	 We catch fish, when we types word 

correctly in TUX Typing.
	 3.	 It helps us learn to type faster and 

better.
	 4.	 Letters and fish fall from the sky.
	 5.	 TUX typing is a game played on a 

computer.
Art Integration
	 Do yourself.

CHAPTER-7
Using Google Docs-Your 

Digital Notebook!

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (a)
	 3.	 (a)	 4.	 (a)
	 5.	 (b)
B.	 Fill in the blanks:
	 1.	 notebook
	 2.	 Blank
	 3.	 Drawing
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	 4.	 microphone
	 5.	 automatically
C.	 True/False:
	 1.	 F	 2.	 T	 3.	 F
	 4.	 T	 5.	 F
D.	 Answer the following questions:
	 1.	 Google Docs is used for writing, 

drawing and doing homework.
	 2.	 We can start a new document by 

clicking on + Blank Document 
button.

	 3.	 Go the Insert menu and choose 
Drawing.

	 4.	 Google Docs saves our work 
automatically.

	 5.	 Yes, we can share our work with 
others.

Art Integration
	 Do yourself.

CHAPTER-8
Typing Heroes–Mastering 
the Keyboard Adventure!

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (b)
	 3.	 (a)	 4.	 (a)
	 5.	 (a)
B.	 Fill in the blanks:
	 1.	 ;
	 2.	 typing
	 3.	 fun
	 4.	 homework
	 5.	 screen
C.	 True/False:
	 1.	 F	 2.	 T	 3.	 F
	 4.	 F	 5.	 T
D.	 Answer the following questions:
	 1.	 The home raw keys are A, S, D, F, J, K, 

L and ; .
	 2.	 It is important to use all fingers while 

typing as it helps to type faster and 

more accurately.
	 3.	 We can practice by playing typing 

games and typing words every day.
	 4.	 We should practice daily and try not 

look at the keyboard.
	 5.	 A good typist can finish work faster 

and make fewer mistakes.
Art Integration
	 Do yourself.

Worksheet - 1
A.	 Tick (3) the correct answer:
	 1.	 (c)	 2.	 (c)
	 3.	 (b)	 4.	 (a)
	 5.	 (b)
B.	 Fill in the blanks:
	 1.	 mouse	 2.	 home
	 3.	 gently	 4.	 keyboard
	 5.	 .txt
C.	 True/False:
	 1.	 F	 2.	 T	 3.	 T
	 4.	 T	 5.	 F
D.	 Answer the following questions:
	 1.	 Computers are used in the school 

library, to keep the records of books.
	 2.	 (1) Keep the computer safe from dust 

by covering it, when not in use. (2) 
Clean the computer with a soft, tidy 
and dry cloth.

	 3.	 Notepad is the software that is used 
for typing text on the computer.

D.	 Match the following pictures with 
their activity.

	 1.	 Studying
	 2.	 Billing counters at shops
	 3.	 Scientific researches
	 4.	 Online shopping

Worksheet - 2
A.	 Tick (3) the correct answer:
	 1.	 (c)	 2.	 (c)



10 Computer 1 to 5

	 3.	 (c)	 4.	 (b)
	 5.	 (a)

B.	 Fill in the blanks:
	 1.	 double	 2.	 fish
	 3.	 sky	 4.	 notebook
	 5.	 typing
C.	 True/False:

	 1.	 T	 2.	 T	 3.	 T
	 4.	 T	 5.	 T
D.	 Answer the following questions:
	 1.	 Wordpad is a program that is used 

for typing text on a computer.
	 2.	 The name of the penguin is TUX.
	 3.	 We can start a new document by 

clicking on + Blank Document 
button.

E.	 Name the following with the help of given word in the box.

ll
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Computer - 3

CHAPTER-1
Working of a Computer

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (b)
	 3.	 (b)	 4.	 (b)
	 5.	 (a)
B.	 Fill in the blanks:
	 1.	 devices	 2.	 hardware
	 3.	 ALU	 4.	 WordPad
	 5.	 input
C.	 Tick (3) the correct statements and 

cross (7) out the wrong ones:
	 1.	 3	 2.	 3	 3.	 3
	 4.	 7	 5.	 3
D.	 Match the following:
	 1.	 c	 2.	 d
	 3.	 e	 4.	 a
	 5.	 b
E.	 Answer in one line:
	 1.	 Input – Process – Output
	 2.	 + and – are operators and 40, 60, 30 

are numbers (operands).
	 3.	 Central Processing Unit
	 4.	 Arithmetic Logic Unit
	 5.	 Central Unit
F.	 Answer the following questions:
	 1.	 Input is the data or instructions given 

to the computer to process.
	 2.	 Output is the result that we get after 

the computer processes the input.
	 3.	 Central Processing Unit processes 

the data as per the given instructions.
	 4.	 Input devices gives data, the CPU 

processes it, and output devices 
show the result.

	 5.	 Computer Hardware refers to the 
physical parts of a computer, like the 

keyboard, monitor and CPU.
Art Integration
	 Do yourself.

CHAPTER-2
Introduction to Windows 10

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (c)	 3.	 (c)
	 4.	 (a)	 5.	 (b)
B.	 Fill in the blanks:
	 1.	 graphics	 2.	 icons
	 3.	 Wallpaper
	 4.	 Operating system
	 5.	 ribbons
C.	 Tick (3) the correct statements and 

cross (7) out the wrong ones:
	 1.	 7	 2.	 3	 3.	 3
	 4.	 7	 5.	 3
D.	 Explain the following ones:
	 1.	 Tiny pictures on the desktop are 

called icons.
	 2.	 Windows is an operating system.
	 3.	 Wallpaper is the cover of desktop.
	 4.	 Screen saver is moving graphics 

which appear on the screen when 
the computer remain idle.

	 5.	 The programs that can be placed on 
the taskbar, called pinned programs.

E.	 Match the following:
	 1.	 e	 2.	 d	 3.	 a
	 4.	 b	 5.	 c
F.	 Answer the following questions:
	 1.	 A software that manages entire 

computer system is known as 
operating system. Examples : 
Windows, Linux, Mac OS, Chrome 
OS.
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	 2.	 Cortana is a voice-enable assistant 
in windows 10 that helps user using 
voice commands.

	 3.	 System Tray is the small section on 
the right side of the Taskbar that 
displayed icons for background 
running applications.

	 4.	 Working area is a large area located 
in the centre of the window where 
we open and work on programs and 
files.

	 5.	 We use the Scroll bars to scroll the 
window vertically or horizontally.

	 6.	 Software programs are applications 
that help us perform tasks on a 
computer. Examples : MS Paint, 
WordPad, TuxtPaint, Notepad.

Art Integration
	 Do yourself.

CHAPTER-3
Working with Files 

and Folders

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)
	 3.	 (c)	 4.	 (b)
	 5.	 (b)
B.	 Fill in the blanks:
	 1.	 unique	 2.	 image
	 3.	 desktop	 4.	 files
	 5.	 audio
C.	 Tick (3) the correct statements and 

cross (7) out the wrong ones:
	 1.	 3	 2.	 7	 3.	 3
	 4.	 7	 5.	 3
D.	 Match the following:
	 1.	 d	 2.	 c
	 3.	 e	 4.	 b
	 5.	 a
E.	 Explain the following terms in one 

sentences:
	 1.	 A folder is a place where we can store 

multiple files on a computer.
	 2.	 A sub-folder is a folder inside another 

folder.
	 3.	 A drive is a storage space in a 

computer where files and folders are 
kept.

	 4.	 It refers to the information or data 
stored inside a file or folder.

F.	 Answer the following questions:
	 1.	 Different computer files opens in 

different software or programs as 
image file is opened in MS Paint 
while text, files opens in Notepad 
and a video file opens in Media 
Player.

	 2.	 It refers to the information or data 
stored inside a file or folder.

	 3.	 A folder is a place where we can store 
multiple files on a computer.

	 4.	 To create a folder in This PC:
		  (a) �Right-click in an empty space.
		  (b) �Select New and click on 'Folder'.
	 (c) �Then type a name and press Enter.
	 To save files in desired folder:
	 (a) File > Save
	 (b) In the Save As option, choose the 

desired folder.
	 (c) Type a file name, and click 'Save'.
Art Integration
	 Do yourself.

CHAPTER-4
Introduction to 
MS Word 2019

A.	 Tick (3) the correct answer:
	 1.	 (c)	 2.	 (c)
	 3.	 (b)	 4.	 (b)
	 5.	 (c)
B.	 Fill in the blanks:
	 1.	 tab	 2.	 cursor
	 3.	 scrolling	 4.	 format
	 5.	 mouse
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C.	 Tick (3) the correct statements and 
cross (7) out the wrong ones:

	 1.	 3	 2.	 3	 3.	 7
	 4.	 7	 5.	 7
D.	 Match the following columns:
	 1.	 c	 2.	 d	 3.	 e
	 4.	 a	 5.	 b
E.	 Answer the following questions:
	 1.	 Some features of word processor are 

:
		  (a) � Typing, editing and formatting 

text.
		  (b) � Perform spell and grammar 

check.
		  (c) � Preview and print documents.
		  (d) � Inserting images, shapes and 

tables.
	 2.	 The title bar is located at the top of 

the MS Word window and shows the 
name of the document. It also has 
control buttons.

	 3.	 Ribbons are wide strips which 
contain all commands. Each ribbon 
is opened by a tab.

	 4.	 To save the document in MS Word, 
we click on ''File'' then ''Save As'', 
choose a location, type a name, and 
click ''Save''. We can also press Ctrl+S 
to save quickly.

Art Integration
	 Do yourself.

CHAPTER-5
Kinds of Computer Software

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (c)	 3.	 (a)
	 4.	 (c)	 5.	 (c)
B.	 Fill in the blanks:
	 1.	 system	 2.	 Multi-user
	 3.	 single-user	 4.	 Mac OS
	 5.	 MS-DOS

C.	 Tick (3) the correct statements and 
cross (7) out the wrong ones:

	 1.	 3	 2.	 3	 3.	 7
	 4.	 7	 5.	 3
D.	 Answer the following questions:
	 1.	 (a) Microsoft Windows 95�  

(b) MS-DOS
	 2.	 GUI – Graphical User Interface
		  CUI – Character User Interface
	 3.	 An operating system is a software 

that helps to run and manage a 
computer and its programs.

	 4.	 A multi-user operating system allows 
more than one person to use the 
computer at the same time.

	 5.	 Two software packages for 
graphics and designing are : 
(a) Corel Draw Graphics Suite 
(b) Adobe CS

Art Integration
	 Do yourself.

CHAPTER-6
Computer Languages

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (c)
	 3.	 (a)	 4.	 (b)
	 5.	 (c)
B.	 Fill in the blanks:
	 1.	 Assembly	 2.	 High
	 3.	 Machine	 4.	 Java
	 5.	 LOGO
C.	 Tick (3) the true statements and cross 

(7) out the false statements:
	 1.	 7	 2.	 7	 3.	 3
	 4.	 7	 5.	 3
D.	 Answer the following questions:
	 1.	 Two advantages of high level 

languages are :�  
(a) Commands are written in simple 
English language. (b) Knowledge of 
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hardware and Binary Arithmetic is 
not required.

	 2.	 Assembly language is a low-level 
programming language that uses 
symbols and short codes instead of 
0s and 1s.

	 3.	 Computer understands only 
machine language (0s and 1s), so we 
need to convert our programs for the 
computer to process them.

	 4.	 A compiler is software that converts 
a high-level language program into 
machine language at once.

	 5.	 High-level languages like Python, 
Java and C++ use simple English 
words for programming.

Art Integration
	 Do yourself.

CHAPTER-7
Fun with Scratch

A.	 Tick (3) the correct answer:
	 1.	 (c)	 2.	 (c)
	 3.	 (c)	 4.	 (c)
	 5.	 (b)
B.	 Fill in the blanks:
	 1.	 Scratch	 2.	 Motion
	 3.	 Script	 4.	 Blocks
C.	 Tick (3) the correct statements and 

cross (7) out the wrong ones:
	 1.	 3	 2.	3
	 3.	 7	 4.	3
	 5.	 3
D.	 Match the following columns:
	 1.	 b	 2.	 c
	 3.	 a	 4.	 d
D.	 Answer the following questions:
	 1.	 Instructions or set of instructions 

given to computer to perform task is 
called programming.

	 2.	 Stage is used to keep all the sprites 
which we add in our project. Our 

final output of animation is shown in 
stage.

	 3.	 We can add backdrop, choosing  from 
backdrop library or by importing an 
image in scratch.

	 4.	 Scratch is a visual program. In it, we 
can create interactive animations, 
games and stories.

	 5.	 Sprite can be turned in the following 
ways :

		  (a) Clockwise.
		  (b) Turn Anti-clockwise.
		  (c) �Point the sprite up, down, left or 

right.
Art Integration
	 Do yourself.

CHAPTER-8
The Internet and Its Uses

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (c)
	 3.	 (a)	 4.	 (b)
	 5.	 (b)
B.	 Fill in the blanks:
	 1.	 computers	 2.	 messages
	 3.	 browser	 4.	 permission
	 5.	 educational
C.	 Match the following:
	 1.	 c	 2.	 a
	 3.	 e	 4.	 b
	 5.	 d
C.	 Tick (3) the correct statements and 

cross (7) out the wrong ones:
	 1.	 7	 2.	3
	 3.	 3	 4.	7
	 5.	 3
E.	 Answer the following questions:
	 1.	 The internet connects millions of 

computer across the world, allowing 
people to communicate, learn and 
have fun.
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	 2.	 Two uses of the internet are :
		  (a) � Students can use the internet to 

find E-books and articles to read.
		  (b) � The internet also has many 

entertaining videos, like cartoons 
and funny shows.

	 3.	 A web browser is a special program 
that helps you to visit websites.

		  Some common web browsers are 
: Google Chrome, Microsoft Edge, 
and Mozilla Firefox.

	 4.	 It we see something strange on 
the internet that makes us feel 
uncomfortable or scared, tell an adult 
right away.

	 5.	 Sharing personal information 
like your name, address or phone 
number can be unsafe. Strangers 
may use it wrongly.

Art Integration
	 Do yourself.

Worksheet - 1
A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (a)
	 3.	 (c)	 4.	 (b)
	 5.	 (c)
B.	 Fill in the blanks:
	 1.	 hardware	 2.	 icons
	 3.	 unique	 4.	 files
	 5.	 cursor
C.	 True/False:
	 1.	 T	 2.	 T
	 3.	 T	 4.	 F
	 5.	 T
D.	 Answer the following questions:
	 1.	 Central Processing Unit.
	 2.	 Cortana is a voice-enable assistant in 

windows 10 that helps users using 
voice commands.

	 3.	 Some features of word processor are:
		  (a) � Typing, editing and formatting 

text.
		  (b) � Perform spell and grammar 

check.
		  (c) � Preview and print documents.
		  (d) � Inserting images, shapes and 

tables.
	 4.	 To create a folder in This PC:
		  (a) � Right-click in an empty space.
		  (b) � Select New and click on 'Folder'.
		  (c) � Then type a name and press 

Enter.
C.	 Match the following columns:
	 1.	 d	 2.	 c
	 3.	 e	 4.	 b
	 5.	 a

Worksheet - 2
A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (b)
	 3.	 (b)	 4.	 (c)
	 5.	 (a)
B.	 Fill in the blanks:
	 1.	 system
	 2.	 Mac OS
	 3.	 Assembly
	 4.	 Blocks
	 5.	 educational
C.	 True/False:
	 1.	 T	 2.	 T	 3.	 T
	 4.	 T	 5.	 T
D.	 Answer the following questions:
	 1.	 (a) Microsoft Windows 95�  

(b) MS-DOS
	 2.	 Assembly language is a low-level 

programming language that uses 
symbols and short codes instead of 
0s and 1s.

	 3.	 Scratch is a visual program. In it, we 
can create interactive animations, 
games and stories.

	 4.	 Two uses of the internet are :
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		  (a) � Students can use the internet to 
find E-books and articles to read.

		  (b) � The internet also has many 
entertaining videos, like cartoons 

and funny shows.
C.	 Match the following columns:
	 1.	 b	 2.	 c
	 3.	 a	 4.	 d


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Computer - 4

CHAPTER-1
Multimedia on Computers 

Using Windows 10

A.	 Tick (3) the correct answer:
	 1.	 (c)	 2.	 (a)
	 3.	 (b)	 4.	 (b)
	 5.	 (b)
B.	 Fill in the blanks with suitable words 

given in the box below :
	 1.	 animations
	 2.	 Windows Media Player
	 3.	 Photo editing
	 4.	 Auto Play
	 5.	 Windows Media Player
C.	 Tick (3) the true statements and cross 

(7) for the false statements.
	 1.	 3	 2.	 7	 3.	 7
	 4.	 3	 5.	 7
D.	 Match the following columns:
	 1.	 b	 2.	 e
	 3.	 c	 4.	 a
	 5.	 d
E.	 Answer the following questions:
	 1.	 The main benefit of using multimedia 

in educational content is it offers 
interactive learning resources, 
instructional video and simulations 
to enrich learning.

	 2.	 Two software applications that can 
be use to edit images on windows 10 
are : Adobe Photoshop and Paint.

	 3.	 It helps the computer automatically 
show options when a CD is inserted.

	 4.	 Windows Media Player
	 5.	 It is important to update graphics 

drivers when playing games on a 
windows 10 computer because it 
helps games run better and prevents 

problems with graphics.
Art Integration
	 Do yourself.

CHAPTER-2
Window Settings

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (b)
	 3.	 (b)	 4.	 (c)
	 5.	 (a)
B.	 Fill in the blanks with suitable words 

given in the box below :
	 1.	 3D Text
	 2.	 clock
	 3.	 wallpaper
	 4.	 personalization
	 5.	 Windows
C.	 Tick (3) the true statements and cross 

(7) for the false statements.
	 1.	 3	 2.	3
	 3.	 3	 4.	3
	 5.	 3
D.	 Write a short note on each of the 

following.
	 1.	 A screen saver is an animated or 

moving image that appears on the 
computer screen when it is idle for a 
certain time.

	 2.	 Customizing these settings to 
fit our preferences is known as 
personalization.

	 3.	 A windows theme is a combination 
of background, sounds and screen 
saver that change the appearance of 
the computer screen.

	 4.	 Wallpaper is the background image 
displayed on the desktop screen.

E.	 Answer the following questions:
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	 1.	 An operating system manages the 
functioning of a computer system.

	 2.	 Customizing these settings to 
fit our preferences is known as 
personalization.

	 3.	 The steps for personalizing the 
desktop are :

		  (a) Right-click on the desktop.
		  (b) �Select  the ''Personalization'' 

option.
		  (c) �Choose the desired background, 

theme or screen saver.
		  (d) �Click 'Apply' and then 'OK'.
	 4.	 (a) Open ''Settings''.
		  (b) Click on "Personalization".
		  (c) Select "Themes".
		  (d) �Choose a new theme and apply 

it.
	 5.	 (a) �Click on the Lock screen section 

> screen saver settings.
		  (b) �Click on the Screen saver drop 

down and select the screen saver 
of your choice.

		  (c) Set the wait time.
		  (d) Click on the OK button.
Art Integration
	 Do yourself.

CHAPTER-3
Windows 10 : Working With Files and 

Folders

A.	 Tick (3) the correct answer:
	 1.	 (c)	 2.	 (b)
	 3.	 (a)	 4.	 (c)
B.	 Fill in the blanks with suitable words 

given in the box below :
	 1.	 permanently
	 2.	 Ctrl+V
	 3.	 sub-folder
	 4.	 folder

	 5.	 primary
C.	 Tick (3) the true statements and cross 

(7) for the false statements.
	 1.	 3	 2.	 3	 3.	 3
	 4.	 3	 5.	 3
D.	 Match the following columns:
	 1.	 d	 2.	 c	 3.	 e
	 4.	 a	 5.	 b
E.	 Answer the following questions:
	 1.	 A file is a collection of data stored on 

a computer.
		  To create a file, click on the desktop, 

select "New", choose a file type and 
name it.

	 2.	 A folder is designed to store files and 
other folders, which are referred to 
as sub-folders.

		  The advantages of folders are:
		  (a) �Helps in organizing files properly.
		  (b) �We can easily share an entire 

folder with others.
	 3.	 The 'This PC' window helps in 

managing files and folders on the 
computer. It shows all drives, folders 
and storage devices connected to the 
computer.

	 4.	 A deleted file moves to the Recycle 
Bin. To restore a deleted file, open 
the Recycle Bin, right-click on the file 
and select Restore.

	 5.	 The F2 function key is used to rename 
files and folders.

Art Integration
	 Do yourself.

CHAPTER-4
Edit and Format Word Document

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (b)
	 3.	 (c)	 4.	 (c)
	 5.	 (b)
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B.	 Fill in the blanks with suitable words 
given in the box below :

	 1.	 red	 2.	 Toggle
	 3.	 Sentence	 4.	 Thesaurus
	 5.	 Subscript
C.	 Tick (3) the true statements and cross 

(7) for the false statements.
	 1.	 3	 2.	 3	 3.	 7
	 4.	 3	 5.	 3
D.	 Match the following columns:
	 1.	 g	 2.	 f
	 3.	 e	 4.	 c
	 5.	 h	 6.	 b
	 7.	 i	 8.	 a
	 9.	 d
E.	 Answer the following questions:
	 1.	 Editing is a crucial function 

performed within a word processor, 
involving the correction and 
modification of text documents using 
various editing tools.

	 2.	 Formatting refers to altering the 
visual aspects of the text, and other 
elements such as changing the font 
style, color and size.

	 3.	 Thesaurus helps to find similar 
(synonyms) or opposites (antonyms) 
words.

	 4.	 Right-click the word 'ture' and choose 
the correct spelling 'true'.

	 5.	 (a) Ctrl+Page Up
		  (b) Ctrl+Right arrow key
		  (c) UP arrow
		  (d) End
		  (e) Home Key
Art Integration
	 Do yourself.

CHAPTER-5
MS Word : 

Text Enhancement

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)
	 3.	 (a)	 4.	 (a)
	 5.	 (c)
B.	 Fill in the blanks with suitable words 

given in the box below :
	 1.	 center, justified
	 2.	 style
	 3.	 Line
	 4.	 border
	 5.	 Watermark
C.	 Tick (3) the true statements and cross 

(7) for the false statements.
	 1.	 3	 2.	 3	 3.	 7
	 4.	 7	 5.	 3
D.	 Answer the following questions:
	 1.	 Text alignment means to align the text 

and set it on a page or a document. 
By default, the text is aligned to the 
left.

	 2.	 Left alignment – Ctrl + L
		  Centre alignment – Ctrl + E
		  Justified alignment – Ctrl + J
	 3.	 A bullet list is used when there is no 

fixed sequence of the points while 
in a numbered list, the sequence of 
points remains fixed.

	 4.	 Borders are lines drawn around the 
text or entire page. They are applied 
to make the page more attractive.

	 5.	 Watermarks are the faint imprints of 
text or images. They help in claiming 
the ownership of a document and 
provide information about the 
original owner or creator of the 
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document.
Art Integration
	 Do yourself

CHAPTER-6
MS Word : 

Working with Graphics

A.	 Tick (3) the correct answer:
	 1.	 (d)	 2.	 (c)
	 3.	 (c)	 4.	 (a)
	 5.	 (a)
B.	 Fill in the blanks with suitable words 

given in the box below :
	 1.	 top	 2.	 remove
	 3.	 ClipArt	 4.	 styles
	 5.	 shapes
C.	 Tick (3) the true statements and cross 

(7) for the false statements.
	 1.	 3	 2.	7
	 3.	 3	 4.	3
	 5.	 7
D.	 Answer the following questions:
	 1.	 (a) Click on the picture.
		  (b) �A rotating icon appears at the top.
		  (c) �Hold the rotation handle with 

left-click of the mouse and drag 
the mouse slowly in clockwise or 
anticlockwise direction.

	 2.	 (a) Click on the picture.
		  (b) Go to the Layout options.
		  (c) �Choose how the text should wrap 

around the image like square or 
Right.

	 3.	 Cropping is applied to remove the 
unwanted region of an image or 
picture.

	 4.	 ClipArt is a group of illustrations, 
symbols, paragraphs, videos and 
audios that remain available for 
computer users to insert into their 
document.

	 5.	 To insert various shapes :
		  Go to the insert tab, then to 

illustrations group and now click 
on shapes drop-down to select the 
required shape.

Art Integration
	 Do yourself

CHAPTER-7
Introduction to Internet

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (c)
	 3.	 (d)	 4.	 (c)
	 5.	 (c)
B.	 Fill in the blanks with suitable words 

given in the box below :
	 1.	 Internet
	 2.	 communication
	 3.	 Modem
	 4.	 Home
	 5.	 Hyperlink

C.	 Tick (3) the true statements and cross 
(7) for the false statements.

	 1.	 3	 2.	 7	 3.	 3
	 4.	 7	 5.	 3
D.	 Write a short note on each of the 

following:
	 1.	 A hyperlink is a clickable text or 

image that connects one web page to 
another.

	 2.	 A web browser is a software that 
allows users to access view and 
interact with various types of content 
on a web page.

	 3.	 The homepage is the initial or main 
page of a website.

	 4.	 A search engine is a type of website 
designed to help users locate 
information on the world wide web.

	 5.	 The Uniform Resource Locator is 
the unique address that identifies a 
specific webpage.
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D.	 Match the following columns:
	 1.	 c	 2.	 e
	 3.	 a	 4.	 d
	 5.	 b
F.	 Answer the following questions:
	 1.	 The Internet is a global system that 

connects networks worldwide, 
often referred to as a "network of 
networks".

	 2.	 Two uses of internet are :
		  (a) �Communicate with friends and 

family.
		  (b) �Online shopping and Banking.
	 3.	 The basic requirement for an internet 

connection are: 
		  (a) �A computer or mobile
		  (b) �A modem or dongle.
		  (c) �An internet connection from a 

service provider.
	 4.	 The World Wide Web (www) is a 

collection of websites and web pages 
we can visit using the internet.

	 5.	 To save a searched image on the 
computer:

		  (a) �Click on image categories then 
right click on the selected image 
and choose the Save Image As 
option.

		  (b) �The Save Picture dialog box will 
appear. Specify the location and 
file name to save and click on the 
save button.

Art Integration
	 Do yourself.

CHAPTER-8
Programming Concepts 

with Scratch

A.	 Tick (3) the correct answer:
	 1.	 (d)	 2.	 (b)
	 3.	 (a)	 4.	 (c)
	 5.	 (b)

B.	 Fill in the blanks with suitable words 
given in the box below :

	 1.	 programming
	 2.	 visual	 3.	 Costumes
	 4.	 sounds	 5.	 backdrop
C.	 Tick (3) the true statements and cross 

(7) for the false statements.
	 1.	 3	 2.	7
	 3.	 3	 4.	7
	 5.	 3
D.	 Match the following columns:
	 1.	 d	 2.	 e
	 3.	 b	 4.	 c
	 5.	 a
E.	 Answer the following questions:
	 1.	 To launch the Scratch applications :
		  (a) Click on Start.
		  (b) Click on Scratch.
	 2.	 The file menu is used to create a new 

project, open an existing project, 
save your project, or save it to your 
computer.

	 3.	 When you click on the code tab on 
the left side of the interface, the code 
panel opens up. The panel displays 
a variety of blocks organised into 
different categories, such as Motion, 
Events, Looks, variables and control.

	 4.	 Event handling is when something 
happens (like clicking a key or sprite) 
and it starts an action. For example 
using the block "when green flag 
clicked" is an event.

	 5.	 The stpes for changing sprite's 
costume are:

		  (a) �Click on the sprtie you want to 
edit.

		  (b) Click on the costume tab.
		  (c) �Choose a costume from the library 

or draw a new one.
		  (d) �Click on the costume to apply it 

to the sprite.
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Art Integration
	 Do yourself

CHAPTER-9
More About Scratch

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (b)
	 3.	 (a)	 4.	 (b)
	 5.	 (a)
B.	 Fill in the blanks with suitable words 

given in the box below :
	 1.	 Looks	 2.	 Say
	 3.	 Cat	 4.	 sound
	 5.	 execute
C.	 Tick (3) the true statements and cross 

(7) for the false statements.
	 1.	 3	 2.	 7	 3.	 3
	 4.	 3	 5.	 7
D.	 Match the following columns:
	 1.	 c	 2.	 d
	 3.	 b	 4.	 e
	 5.	 a
E.	 Answer the questions given below:
	 1.	 We can change the color of a sprite in 

Scratch by using the "Change [color 
effect] by" block to change the color 
of a sprite.

	 2.	 Use the "Say [Hello!] for [2] seconds" 
block from the Looks category.

	 3.	 The "Play sound [sound name] until 
done" block is used.

	 4.	 Yes, we can draw or upload our own 
backdrop in Scratch.

	 5.	 The "Hide" block makes the sprite 
disappear from the stage.

Art Integration
	 Do yourself.

Worksheet - 1
A.	 Tick (3) the correct answer:
	 1.	 (c)	 2.	 (b)

	 3.	 (a)	 4.	 (c)
B.	 Fill in the blanks:
	 1.	 Adobe Photoshop
	 2.	 clock
	 3.	 folder	 4.	 red
C.	 True/False:
	 1.	 7	 2.	3
	 3.	 3	 4.	3
D.	 Answer the following questions:
	 1.	 The main benefit of using multimedia 

in educational content is, it offers 
interactive learning resources, 
instructional video and simulations 
to enrich learning.

	 2.	 The steps for personalizing the 
desktop are :

		  (a) Right-click on the desktop.
		  (b) �Select the ''Personalization'' 

option.
		  (c) �Choose the desired background, 

theme or screen saver.
		  (d) �Click 'Apply' and then 'OK'.
	 3.	 A file is a collection of data stored on 

a computer.
		  To create a file, click on the desktop, 

select "New", choose a file type and 
name it.

	 4.	 Editing is a crucial function 
performed within a word processor, 
involving the correction and 
modification of text documents using 
various editing tools.

Worksheet - 2
A.	 Tick (3) the correct answer:
	 1.	 (d)	 2.	 (c)
	 3.	 (b)	 4.	 (a)
B.	 Fill in the blanks:
	 1.	 delete
	 2.	 communication
	 3.	 visual
	 4.	 Looks
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C.	 Answer the following questions:
	 1.	 ClipArt is a group of illustrations, 

symbols, paragraphs, videos and 
audios the remain available for 
computer users to insert into their 
document.

	 2.	 A search engine is a type of website 
designed to help users locate 
information on the world wide web.

	 3.	 To launch the Scratch applications :

		  (a) Click on Start.
		  (b) Click on Scratch.
	 4.	 We can change the color of a sprite in 

Scratch by using the "Change [color 
effect] by" block to change the color 
of a sprite.

D.	 Match the following:
	 1.	 c	 2.	 d
	 3.	 a	 4.	 b


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Computer - 5

CHAPTER-1
Evolution of Computers

Exercise

A.	 Tick () the correct answer :
	 1.	 (a)	 Heaven
	 2.	 (b)	Blaise Pascal
	 3.	 (a)	 Stepped Reckoner
	 4.	 (a)	 Mainframe computers
	 5.	 (d)	Supercomputers
B.	 Fill in the blanks with the help of 

words given in the box below :
	 1.	 Tablet
	 2.	 5000 years
	 3.	 Difference Engine
	 4.	 Microcomputer
	 5.	 Supercomputers
C.	 Distinguish between the following :
	 1. 	 Counting frame : It is a simple 

wooden tool used for counting.
		  Arithmetic Machine : It was the 

first calculator developed by Blaise 
Pascal to perform addition and 
subtraction.

	 2.	 Laptop : A portable computer with a 
keyboard and screen.

		  Tablet : A small, light weight device 
with a touchscreen, and no physical 
keyboard.

	 3.	 Mainframe computers : Used in big 
offices and banks for storing large 
amount of data.

		  Supercomputer : Used for scientific 
research and solving complex 
problems very quickly.

D.	 Match the following columns :
	 1. (c), 2. (d), 3. (a), 4. (b)

E.	 Answer the following questions:
	 1.	 The counting frame was developed 

about 5000 years ago. It was 
commonly known as the Abacus. It 
had rods and beads in it and was the 
first calculating device. It was used 
for simple mathematical calculation 
such as addition, subtraction and 
multiplication.

	 2.	 Napier's bones was a device framed 
by John Napier in 1617, which was 
based on Rabdology. This device 
was more advanced than abacus 
as it allowed the users to perform 
division and calculate square roots.

	 3.	 Professor Howard Aiken made 
the first mechanical computer, 
named Mark 1, 1944. It was the first 
computer in real sense.

	 4.	 Microcomputers are of different 
types like desktops, laptops, and 
tablets. They are used at homes, 
schools, and offices.

	 5.	 Charles Babbage developed the 
Analytical Engine in the year 1833.

Art Integration

	 Do yourself.

CHAPTER-2
MS Word 2019: Page Layout and 

Hyperlinks

Exercise

A.	 Tick () the correct answer :
	 1.	 (a)	 4
	 2.	 (b)	Landscape
	 3.	 (d)	All of these
	 4.	 (a)	 Text box
	 5.	 (a)	 Symbols
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B.	 Fill in the blanks with the help of 
words given in the box below :

	 1.	 Custom
	 2.	 Portrait
	 3.	 Header, Footer
	 4.	 A4, A5
	 5.	 picture
C.	 State True (T) or False (F) :
	 1. T, 2. F, 3. F, 4. T, 5. T.
D.	 Answer the following questions:
	 1.	 In MS Word, page layout is a term 

used to describe how each page of 
your document will appear when 
printed.

	 2.	 The page margins in MS Word are: 
Top, Bottom, Left and Right.

	 3.	 Page orientation is the direction 
in which a document appears in 
printed form. The two types of 
a page orientation are portrait 
(vertical) and landscape (horizontal). 
An exam-scheme usually fits best in 
landscape orientation.

	 4.	 To insert a blank page in MS Word, 
go to the Insert tab and click on 
Blank Page option.

	 5.	 Symbols like , , ® ♣ → and  special 
characters like @, $ and ©. They 
are used in documents to represent 
mathematical, legal, currency, and 
other special notations. They can 
be inserted through the Insert > 
symbol option.

Art Integration

	 Margin
	 Header
	 Layout
	 Portrait
	 Footer

CHAPTER-3
MS Word : Working with Tables

Exercise

A.	 Tick () the correct answer :
	 1.	 (c)	 Both a and b
	 2.	 (c)	 three ways
	 3.	 (b)	Split cell
	 4.	 (c)	 Merge cell
	 5.	 (d)	All of these
B.	 State True (T) or False (F) :
	 1. T, 2. F, 3. F, 4. T, 5. T.
C.	 Match the following columns :
	 1. (e), 2. (c), 3. (d), 4. (a), 5. (b).
D.	 Answer the following questions:
	 1.	 A table is a grid made up o rows and 

columns used to organize data in a 
document.

	 2.	 A cell is the intersection of a row 
and a column in a table where data 
entered.

	 3.	 Tab → Move to next cell :
		  Shift + Tab → Move to previous cell 

Down Arrow → Move to one row 
down.

	 4.	 To split a cell :
		  Select the cell → Right click → choose 

"Split Cells" → Enter the number of 
rows and columns → click OK.

	 5.	 To Merge Cells :
		  Select four cells → Right click → 

choose "Merge cells" → The Selected 
cells will be combined into one.

Art Integration

	 Do yourself.
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CHAPTER-4
Introduction to Spreadsheets and 

MS Excel

Exercise

A.	 Tick () the correct answer :
	 1.	 (d)	All of these
	 2.	 (b)	B5
	 3.	 (b)	Cell range
	 4.	 (d)	All of these
	 5.	 (c)	 Letter, letters
B.	 Fill in the blanks with the help of 

words given in the box below:
	 1.	 data
	 2.	 column, row
	 3.	 active
	 4.	 cell pointer
	 5.	 workbook

C.	 State True (T) or False (F) :
	 1. T, 2. F, 3. F, 4. T, 5. T.
D.	 Match the following columns :
	 1. (e), 2. (d), 3. (a), 4. (b), 5. (c).
E.	 Answer the following questions:
	 1.	 Electronic spreadsheets are 

computer applications used to 
organize, analyze, and store data 
in tabular form. They consist of 
rows and returns where data can 
be entered, calculated, and visually 
represented using charts and 
graphs, MS Excel is an example of 
an electronic spreadsheet.

	 2.	 The selected cell is termed as the 
Active cell or current cell. It is 
displayed with bold border that 
differentiates it from the rest of the 
cells. The highlighted box is known 
as the cell pointer. To select a cell, 
just click on it. To enter the data in a 
cell you first need to select it.

	 3.	 Each Excel file is called a workbook. 
It can hold several worksheets. The 
default workbook is Book 1.

	 4.	 (a)	 Quick Access Toolbar consists of 
commands that are repeatedly 
used like Save, Undo, Redo, 
Print, etc.

	 	 (b)	Cell range is a group of 
contiguous cells. A cell range 
name contains the cell address 
of the first cell, a colon and the 
last cell address. For example,  
B3 : C5.

	 5.	 Charts are visual representations 
of data in the form of graphs, such 
as bar charts, pie charts, and line 
charts. They are used in Excel to 
make data easier to understand and 
to highlight trends, comparisons, 
and patterns in the data.

Art Integration

	 Do yourself.

CHAPTER-5
MS PowerPoint : Graphics

Exercise

A.	 Tick () the correct answer :
	 1.	 (c)	 Spaceship
	 2.	 (c)	 Middle
	 3.	 (a)	 Chart
	 4.	 (a)	 Axis
	 5.	 (b)	Playback
B.	 Fill in the blanks with the help of 

words given in the box below:
	 1.	 formatting, presentation, pictorial
	 2.	 Tables
	 3.	 relation
	 4.	 Chart tool tab
	 5.	 Video
C.	 Describe the use of the followig in 

PowerPoint 2019.



27Teachers' Manual

	 1.	 Chart used to represent data 
visually in the form of bars, lines 
or pie diagrams, making it easier to 
understand.

	 2.	 Smart Art used to create diagrams 
such as cycles processes, or 
hierarchies to make information 
more engaging and clear.

	 3.	 Picture used to insert images from 
your computer or online sources 
to make slides more attractive and 
informative.

	 4.	 Video used to insert video clips 
which can elp explain topics better 
or make the presentation more 
engaging.

	 5.	 Icon and 3D Models Icons are 
simple symbols that represent 
actions or objects. 3D models add 
depth and interactivity, helping to 
explain complex ideas visually.

D.	 Answer the following questions:
	 1.	 Slide layouts are the systematic 

arrangement and combination of all 
the objects on a slide. They contain 
formatting of text, presentation of 
tables, pictorial charts, SmartArt 
graphics, positioning of pictures, 
online pictures, video, icons and 3D 
Modals.

	 	 (1)	 Title Slide : This is applied at the 
beginning of your presentation 
or to divide sections of your 
presentation.

		  (2)	 Title and Content : This 
functions as default. It is most 
commonly used slide layout 
and is used to give a topic and 
its content.

	 2.	 The steps to be followed for inseting 
table in MS PowerPoint are :

	 	 (1)	 Alternatively, click on insert tab.
	 	 (2)	 In Tables group, click on Table 

button.
	 	 (3)	 Insert Table option from the list.
	 	 (4)	 On Title and Content slide 

layout, click on Table icon. The 
insert table dialog box displays.

	 	 (5)	 Enter the required number of 
columns and click on OK button.

	 3.	 Smart Art Graphic is a visual 
representation of information 
that is used to communicate any 
message or idea effectively. It allows 
to communicate information with 
graphics instead of just using text.

	 4.	 Icons and 3D Models are available 
with PowerPoint 2019 inbuilt form. 
Icons are used to communicate 
visually and 3D Models are objects 
that move in 3D space with height, 
width and depth, as the third 
dimensions.

	 	 Write a short note on:
	 	 (a)	 Title and Content : This functions 

as default. It is most commonly 
used slide layout and is used to 
give a topic and its content.

	 	 (b)	Blank slide layout : A blank 
slide layout is mostly used 
when a picture or other graphic 
object that requires no further 
information, will be inserted to 
cover the whole slide.

Art Integration

	 Do yourself.

CHAPTER-6
MS PowerPoint : Animations and 

Transitions

Exercise

A.	 Tick () the correct answer :
	 1.	 (c)	 Reorder animations
	 2.	 (b)	By clicking Apply to All in the 

Transitions tab
	 3.	 (b)	Review
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	 4.	 (b)	To arrange the order of slides
	 5.	 (a)	 Ctrl + P
B.	 Fill in the blanks with the help of 

words given in the box below:
	 1.	 slide
	 2.	 Animation
	 3.	 Slide Sorter view
	 4.	 outline
	 5.	 sound
C.	 Write the procedure for the following 

tasks in Slide Sorter view:
	 1.	 Double click the slide.
	 2.	 •	 Select a slide
	 	 •	 Go to the Home tab
	 	 •	 Click the copy button in the 

clipboard group.
	 3.	 Select the slide you want to move. 

Drag it to the new location.
	 4.	 Select the slide you want to 

duplicate. Press Ctrl + D.
	 5.	 Select the slide you want to delete. 

Press the Delete key.
D.	 Answer the following questions:
	 1.	 Animations in powerpoint are 

special visual or sound effects that 
can be applied to elements present 
on a slide such as text, shapes, 
images, icons, etc. In powerpoint, 
animations control how objects 
move onto, off of and around the 
different slides.

	 2.	 To add multiple animations to a 
single object :

	 	 (1)	 Select the object you want to 
animate.

	 	 (2)	 In the Animations tab, click on 
Add Animation.

	 	 (3)	 Choose another animation from 
the list.

	 	 (4)	 Use the Animation Pane to 
organize and reorder the 

animations.
	 3.	 The Slide Sorter view is used to 

see all the slides in a presentation 
at once. It allows you to easily 
rearrange, delete, or organise slides 
by dragging and dropping them.

	 4.	 To check for spelling errors in 
PowerPoint go to the "Review" tab 
on the ribbon and click "Spelling". 
PowerPoint will scan the slides and 
suggest corrections for any spelling 
mistakes.

	 5.	 (1)	 Click on File > Print.
	 	 (2)	 Under settings, choose 

Handouts from the print layout 
options.

	 	 (3)	 Select the number of slides per 
page.

	 	 (4)	 Click Print to generate the 
handouts.

Art Integration

	 Do yourself.

CHAPTER-7
Internet Browser and Searching

Exercise

A.	 Tick () the correct answer :
	 1.	 (d)	All of these
	 2.	 (b)	Education
	 3.	 (c)	 Surfing
	 4.	 (a)	 Searching
	 5.	 (a)	 www.google.com
B.	 Fill in the blanks with the help of 

words given in the box below:
	 1.	 Internet
	 2.	 Web Browser
	 3.	 Searching
	 4.	 Enter
	 5.	 WWW
C.	 Write few words about the following :
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	 1.	 Online education is a way of learning 
using the internet. Students attend 
classes and complete assignments 
from home using computers or 
mobile devices.

	 2.	 Video conferencing is a way to 
communicate with others using 
video and audio over the internet. 
It is used for online meetings and 
virtual classes. 

	 3.	 An Internet browser is a software 
used to access websites on the 
internet. It helps users search for 
and view web pages.

D.	 Answer the following questions:
	 1.	 An Internet browser is a software 

used to access websites on the 
internet. It helps users search for 
and view web pages.

	 2.	 The types of Internet Browsers 
are : Skype, Mozilla Firefox, Safari, 
Google Chrome, Internet Explorer, 
Edge and more.

	 3.	 A Web Browser is the same as an 
internet browser. It is a software 
used to access and view websites.

	 4.	 Internet searching means finding 
information on the internet using a 
search engine like Google or Bing.

Art Integration

	 Do yourself.

CHAPTER-8
Programming with Scratch-I

Exercise

A.	 Tick () the correct answer :
	 1.	 (c)	 Coordinates
	 2.	 (b)	Surprise button
	 3.	 (b)	Choose a Sprite
	 4.	 (b)	Script areas
	 5.	 (c)	 Mitchel Resnick

B.	 Fill in the blanks with the help of 
words given in the box below:

	 1.	 block-based
	 2.	 sprite
	 3.	 Paint
	 4.	 Script area
	 5.	 glide
C.	 State True (T) or False (F) :
	 1. F, 2. T, 3. F, 4. F, 5. T.
D.	 Match the following columns :
	 1. (c), 2. (a), 3. (b), 4. (d), 5. (e).
E.	 Answer the following questions:
	 1.	 To start a new script on Scratch, drag 

blocks from the block palette and 
snap them together in the coding 
area. The script usually starts with 
an event block like "when green."

	 2.	 (1)	 Open Scratch.
	 	 (2)	 Click on "File" in the top menu.
	 	 (3)	 Select "Load from your 

computer".
	 	 (4)	 Choose the saved Scratch file 

from your device and click 
"Open".

	 3.	 The main components of the Scratch 
window are Stage, Sprite List, 
Blocks Palette, Script Area, Toolbar, 
Backdrop Area.

	 4.	 Cursor tools help you interact with 
the Scratch interface. Some cursor 
tools include :

	 	 •	 Selector Tool : Used to select and 
move sprites or blocks.

	 	 •	 Duplicate Tool : Creates a copy 
of a sprite or block.

	 	 •	 Delete Tool : Removes a sprite or 
block.

	 	 •	 Grow Tool : Makes a sprite 
bigger.

	 	 •	 Shrink Tool : Makes a sprite 
smaller.
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	 5.	 Motion blocks are blue-colored 
blocks in Scratch that control the 
movement of a sprite. They help 
move the sprite forward, turn it, 
glide to a position, or change its 
position on the stage.

Art Integration

	 Do yourself.

Worksheet - 1
A.	 Tick () the correct answer :
	 1.	 (a)	 Mainframe computers
	 2.	 (b)	Landscape
	 3.	 (c)	 Both a and b
	 4.	 (d)	All of these
	 5.	 (d)	All of these
B.	 Fill in the blanks :
	 1.	 Tablet
	 2.	 custom
	 3.	 picture
	 4.	 column, row
	 5.	 column, row
C.	 State True (T) or False (F) :
	 1. T, 2. F, 3. T, 4. F, 5. T.
D.	 Match the following columns :
	 1. (e), 2. (c), 3. (d), 4. (a), 5. (b).
E.	 Answer the following questions :
	 1.	 The counting frame was developed 

about 5000 years ago. It was 
commonly known as the Abacus. It 
had rods and beads in it and was the 
first calculating device. It was used 
for simple mathematical calculations 
such as addition, subtraction and 
multiplication.

	 2.	 Symbols like , , ® ♣ → and  special 
characters like @, $ and ©. They 
are used in documents to represent 
mathematical, legal, currency, and 
other special notations. They can 

be inserted through the Insert > 
symbol option.

	 3.	 A cell is the intersection of a row 
and a column in a table where data 
is entered.

	 4.	 To split a cell :
		  Select the cell → Right click → choose 

"Split Cells" → Enter the number of 
rows and columns → click OK.

	 5.	 (a)	 Quick Access Toolbar consists of 
commands that are repeatedly 
used like Save, Undo, Redo, 
Print, etc.

	 	 (b)	Cell range is a group of 
contiguous cells. A cell range 
name contains the cell address 
of the first cell, a colon and the 
last cell address. For example, B3 
: C5.

Art Integration

	 Do yourself.

Worksheet - 2

Exercise

A.	 Tick () the correct answer :
	 1.	 (c)	 Spaceship
	 2.	 (a)	 Axis
	 3.	 (b)	To arrange the order of slides
	 4.	 (b)	Education
	 5.	 (c)	 Mitchel Resnick
B.	 Fill in the blanks :
	 1.	 Chart tool tab
	 2.	 Animation
	 3.	 Web Browser
	 4.	 block-based
	 5.	 Script area
C.	 State True (T) or False (F) :
	 1. F, 2. F, 3. T, 4. F, 5. T.



31Teachers' Manual

D.	 Match the following columns :
	 1. (c), 2. (a), 3. (b), 4. (d), 5. (e).
E.	 Answer the following questions:
	 1.	 Slide layouts are the systematic 

arrangement and combination of all 
the objects on a slide. They contain 
formatting of text, presentation of 
tables, pictorial charts, SmartArt 
graphics, positioning of pictures, 
online pictures, video, icons and 3D 
Models.

	 2.	 To add multiple animations to a 
single object :

	 	 (1)	 Select the object you want to 
animate.

	 	 (2)	 In the Animations tab, click on 
Add Animation.

	 	 (3)	 Choose another animation from 
the list.

	 	 (4)	 Use the Animation Pane to 
organize and reorder the 
animations.

	 3.	 An Internet browser is a software 
used to access websites on the 

internet. It helps users search for 
and view web pages.

	 4.	 To start a new script on Scratch, drag 
blocks from the block palette and 
snap them together in the coding 
area. The script usually starts with 
an event block like "when green."

	 5.	 Cursor tools help you interact with 
the Scratch interface. Some cursor 
tools include :

	 	 •	 Selector Tool : Used to select and 
move sprites or blocks.

	 	 •	 Duplicate Tool : Creates a copy 
of a sprite or block.

	 	 •	 Delete Tool : Removes a sprite or 
block.

	 	 •	 Grow Tool : Makes a sprite 
bigger.

	 	 •	 Shrink Tool : Makes a sprite 
smaller.

Art Integration

	 Do yourself.

oo
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CHAPTER-1
MS Word : Mail Merge

A.	 Tick (3) the correct answer:
	 1.	 (c)	 2.	 (a)	 3.	 (d)
	 4.	 (c)	 5.	 (a)

B.	 Fill in the blanks :
	 1.	 sender
	 2.	 First Record, Last Record
	 3.	 Merge Field
	 4.	 Feed
	 5.	 Data Source

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 7	 3.	 3
	 4.	 3	 5.	 3	 6.	 7

D.	 Answer the following questions:
	 1.	 Mail Merge in MS Word is used to 

create documents like letters, emails, 
or labels for multiple recipients, 
with personal information like 
name, address, and contact number 
automatically added. It saves time 
by allowing users to avoid writing 
each recipient’s details individually.

	 2.	 (i) Main Document: The main 
document contains the common 
data or content that needs to be sent 
to multiple recipients. It acts as a 
template for the final documents.

	 	 (ii) Merged Document: The merged 
document is the final output created 
by combining the Main Document 
with the Data Source. Each merged 
document contains personalized 
information for each recipient.

	 3.	 (i) Place the cursor where you want 
to insert the merge field in the main 
document. (ii) Click on the Mailings 
tab and select Insert Merge Field. 
(iii) Choose the required field (like 
name, address, etc.) from the list. 
(iv) Repeat the process for each field 
that needs to be merged.

	 4.	 (i) Click on the Mailings tab. (ii) In 
the Preview Results section, click 
on the Preview Results button to 
see the merged data. (iii) Click on 
Finish & Merge. (iv) Select Edit 
Individual Documents. (v) In the 
Merge to Printer dialog box, click OK 
to create a single merged document 
containing all recipients' data.

	 5.	 1. Go to the Mailings tab and click on 
Envelopes in the Create group. 2. In 
the Envelopes and Labels dialog 
box, enter the delivery and return 
addresses. 3. Click on the Feed button 
to set envelope options like size and 
text formatting. 4. Set the printer feed 
method in the Printing Options tab. 
5. Click OK in the Envelope Options 
dialog box. 6. Finally, click the Print 
button in the Envelopes and Labels 
dialog box to print the envelopes.

Assertion Reason Questions
	 1.	 (b)	 2.	 (a)

Source Based Questions
	 1.	 Mail Merge is a feature that allows 

users to create documents that 
are basically the same but include 
unique elements such as recipient's 
name, address, or other personal 
details.
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	 2.	 Mail Merge allows users to quickly 
create personalized documents for 
multiple recipients by automatically 
inserting their personal information 
into a standard document.

	 3.	 The personal information will be 
automatically added to the main 
document. The benefit is that it saves 
time and effort, as we don’t have 
to manually enter each recipient's 
information for every individual 
document.

Art Integration
	 Do yourself.

CHAPTER-2
MS Excel : Function 

and Formulas

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (a)	 3.	 (a)
	 4.	 (b)	 5.	 (d)

B.	 Fill in the blanks :
	 1.	 Windows
	 2.	 worksheets and charts
	 3.	 clear contents
	 4.	 Insety > comments
	 5.	 Auto Sum

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 3	 3.	 3
	 4.	 3	 5.	 3

D.	 Answer the following questions:
	 1.	 Five formatting tools available on 

Home tab in Excel are: Bold, Italic, 
Font color, Fill color, Merge & center.

	 2.	 A formula is an equation that 
performs a calculation. Like a 
calculator, Excel can execute 

formulas for addition, subtraction, 
multiplication, and division.

	 3.	 The rules to write a formula in Excel 
are : 1. An equal sign must be at the 
start of each formula. 2. There must 
be an operator(s) to operate on the 
data. 3. The data which can be text, 
numbers, date, time, or a cell address.

	 4.	 To apply a colorful border to a cell is 
a worksheet are : 1. Select the cell. 2. 
Right-click and choose ‘Format cells’. 
3. Go to the ‘Border’ tab. 4. Choose 
the color and style. 5. Apply border 
to desired sides and click OK.

	 5.	 The functions of Alignment and Font 
tab buttons in Format Cells dialog 
box:

	 	 Alignment tab: Align text, set orien-
tation, wrap text, merge cell etc.

	 	 Font tab: Change font style, size, 
color, effects (bold, underline), etc.

	 6.	 Operators used for arithmetic 
calculations in Excel:

	 	 l Addition (+)
	 	 l Subtraction (-)
	 	 l Multiplication (*)
	 	 l Division (/)
	 	 l Exponentiation (^)
	 7.	 Purpose of formatting in Excel :
	 	 l � To enhance the appearance and 

readability of data
	 	 l � To differentiate and highlight 

important information
	 	 l � To make data more presentable 

and professional

Assertion Reason Questions
	 1.	 (a)	 2.	 (e)

Source Based Questions
	 1.	 Equal sign (=)	 	 2.  Plus sign (+)
	 3.	 Asterisk (*)



30 Computer 1 to 8

Art Integration
	 Do yourself.

CHAPTER-3
MS Excel : Using Charts 

to Present Data

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (b)	 3.	 (d)
	 4.	 (a)	 5.	 (b)

B.	 Fill in the blanks :
	 1.	 F11	 2.	 items
	 3.	 tools	 4.	 interconnected

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 3	 3.	 3
	 4.	 3	 5.	 3	 6.	 3

D.	 Answer the following questions:
	 1.	 A chart in MS Excel is graphical 

representation of data that helps 
to visualize numerical information 
for better understanding and 
comparison.

	 2.	 There are various types of charts in 
MS Excel: 1. Column Chart: Displays 
data in vertical bars. 2. Bar Chart: 
Displays data in horizontal bars. 
3. Line Chart: Shows the trends 
over time using lines. 4. Pie Chart: 
Represents data as slices of a circle. 
5. Funnel Chart: Shows stages in a 
process or progress. 6. Area Chart: 
Emphasizes the magnitude of values 
over time.

	 3.	 Steps to move a chart on the 
worksheet: 1. The mouse pointer 
transforms into a moving handle 
when you point it anywhere on the 
chart. 2. Click and drag the chart to a 
new location.

	 4.	 The steps to change chart style in a 
worksheet: 1. Select the chart. 2. Go 
to the "Chart Tools" section on the 
Ribbon. 3. Click on the Design tab. 
4. Choose a style from the chart 
styles group.

	 5.	 Resize: Click the chart, then drag the 
handles on the corners.

	 	 Move: Click and drag the chart to a 
new location.

	 	 Print: Go to ''File > Print'' and ensure 
the chart is within the print area.

	 6.	 1. Go to the Insert tab. 2. Click on 
Pictures. 3. Choose This Device or 
Online Pictures. 4. Select the picture 
and click Insert.

Assertion Reason Questions
	 1.	 (c)	 2.	 (b)

Source Based Questions
	 1.	 Columns chart
	 2.	 Pie chart	 3.	 Bar chart

Art Integration
	 Do yourself.

CHAPTER-4
Image Processing 
Basic with GIMP

A.	 Tick (3) the correct answer:
	 1.	 (d)	 2.	 (b)	 3.	 (a)
	 4.	 (a)	 5.	 (c)

B.	 Fill in the blanks :
	 1.	 spray paint	 2.	 Ellipse
	 3.	 Layers	 4.	 scale tool
	 5.	 Smudge tool

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 3	 3.	 3
	 4.	 7	 5.	 7
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D.	 Answer the following questions:
	 1.	 GIMP is a freeware and open-source 

graphic editing tool. It is an acronym 
of GNU Image Manipulation 
Program. This software is used 
for image editing and retouching, 
freeform drawing, converting 
images into different formats, and 
for more specialized work.

	 2.	 (a) Text Tool – to add text on the 
image.

	 	 (b) Brush – Used for freehand 
painting.

	 	 (c) Pencil – Used for drawing hard 
lines.

	 	 (d) Smudge – Used to smudge colors, 
creating a blur.

	 	 (e) Gradient – Used to fill with a 
blend of colors.

	 3.	 Five major parts of GIMP window 
are: 1. Toolbox 2. Menu Bar 3. Docks 
or Dialogs Area 4. Canvas or Image 
5. Status Bar

	 4.	 Three properties of GIMP tools are: 1. 
Opacity – Controls the transparency 
of the tool effect. 2. Size – Adjusts the 
size of the brush or tool. 3. Hardness 
– Determines how soft or sharp the 
brush edges are.

	 5.	 Filters are special effects that can be 
applied to an image or a selected 
region.

	 	 Filters enhance the look of the 
image. They are organized in several 
categories, available as submenus 
under the Filters menu.

Assertion Reason Questions
	 1.	 (a)	 2.	 (b)

Source Based Questions
	 1.	 GIMP is a freeware and open-source 

graphic editing tool.

	 2.	 GNU Image Manipulation Program
	 3.	 GIMP is used for image editing, 

retouching, converting images into 
different formats, and performing 
advanced graphic work.

Art Integration
	 Do yourself.

CHAPTER-5
Internet : Communication 

and Social Platforms

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (c)	 3.	 (c)
	 4.	 (b)	 5.	 (c)

B.	 Fill in the blanks :
	 1.	 online chatting	2.	 Google
	 3.	 chat	 4.	 face-to-face
	 5.	 blogger

C.	 Answer the following questions:
	 1.	 The term ‘online’ refers to computers 

that are connected to a network or 
other devices. The internet offers 
a variety of services that make our 
work faster and easier.

	 2.	 The advantages of video conferencing 
are: (i) It reduces travel expenses. (ii) 
It improves communication. (iii) It 
saves time and money. (iv) It allows 
more people at different locations to 
participate.

	 3.	 A blog is an online personal diary 
or informative article on a specific 
topic. It can be updated frequently. 
The articles that are uploaded on 
a blog are called posts. It is a place 
where you express your thoughts 
and ideas to the world. A blog is 
usually open to the public, which 
means that anyone can read it.
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	 	 Yes, blogs can contain pictures, 
audio, and videos.

	 4.	 Advantages and dis-advantages of 
e-commerce are:

	 	 Advantages: 1. It can be done round 
the clock. 2. Online shopping is 
convenient. 3. The item will be 
delivered directly to your home. 4. 
The price and quality comparison of 
products and services is possible. 5. 
Easily pay through credit/debit card 
while shopping online.

	 	 Disadvantages: 1. Users can’t avail 
themselves of offer warranties and 
guarantees for things purchased 
online. 2. One cannot feel or touch 
items. 3. Despite how secure the 
website promises to be, a key 
disadvantage is the security of credit 
cards. 4. Returning an item online 
is also a cumbersome process than 
in local stores.Assertion Reason 
Questions

	 1.	 (a)	 2.	 (b)

Source Based Questions
	 1.	 Mohit recently cameto know about 

the internet.
	 2.	 The internet offers a variety of 

services that make our work faster 
and easier.

	 3.	 Google, Yahoo! and Bing

Art Integration
	 Do yourself.

CHAPTER-6
Introduction to 

Cloud Computing

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (a)	 3.	 (c)
	 4.	 (b)	 5.	 (d)	 6.	 (d)

B.	 Fill in the blanks :
	 1.	 internet	 2.	 Google Drive
	 3.	 Cloud computing
	 4.	 local
	 5.	 Cloud computing

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 7	 2.	 7	 3.	 3
	 4.	 3	 5.	 7

D.	 Answer the following questions:
	 1.	 Cloud computing is becoming more 

popular for delivering services over 
both public and private networks. 
The term "cloud" refers to the 
combination of hardware, network, 
storage interfaces, and services that 
deliver various aspects of computing 
as a service over a network.

	 	 The term “cloud” is used here as 
a metaphor for how traditional 
methods of sharing audio, video, and 
photographs have become obsolete 
with the advent of cloud computing.

	 2.	 Two examples of cloud storage 
services are: Google Drive and 
Dropbox.

	 3.	 The benefits of using cloud computing 
are: 1. Speed 2. Global Scale 3. Low 
Cost 4. Increased Productivity 5. 
Enhanced Performance 6. Security 7. 
Reliability

	 4.	 Any internet-connected device like 
a laptop, smartphone, or tablet is 
needed to use cloud computing.

	 5.	 Cloud computing helps save space 
on our device by storing files online 
instead of on your device, freeing up 
local storage space.

Assertion Reason Questions
	 1.	 (a)	 2.	 (d)



33Answer Key

Source Based Questions
	 Cloud computing is useful for students 

because it allows them to upload and 
access their homework, projects, and 
notes from any device with an internet 
connection. This makes studying more 
flexible and helps in sharing work with 
teachers and classmates easily.

Art Integration
	 Do yourself.

CHAPTER-7
Programming With Scratch

A.	 Tick (3) the correct answer:
	 1.	 (c)	 2.	 (c)
	 3.	 (b)	 4.	 (d)

B.	 Fill in the blanks :
	 1.	 18
	 2.	 Pen block
	 3.	 sound
	 4.	 Import
	 5.	 purple, appearance

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 7	 2.	 7	 3.	 7
	 4.	 3	 5.	 7

D.	 Answer the following questions:
	 1.	 Motion Blocks :
		  (a) Motion blocks are blocks of 

code that allow you to control the 
movement of your sprites.

	 	 (b) You can use motion blocks to 
move sprites around the stage, 
change their direction, and make 
them bounce off the edges of the 
stage.

	 	 Looks Blocks:
		  (a) Looks are the blocks of code that 

allow you to change the appearance 
of your sprites.

	 	 (b) You can use looks blocks to 
change the sprite’s color, size and 
appearance.

	 2.	 A variable is a changeable value 
recorded in Scratch’s memory. 
Variables can only hold one value 
at a time. Variables block allows us 
to store data, like scores or timers, 
that can change while the program 
is running.

	 3.	 Operators contain blocks like: (a) 
Arithmetic Operators (+, -, *, /) 
(b) Relational Operators (>, <) (c) 
Boolean Operators (and, or, not)

	 	 There are 18 Operators blocks in 
Scratch.

	 4.	 We can import a sound file or record 
a new sound using the Scratch sound 
recorder.

	 5.	 Use Repeat block for actions that 
need to happen a certain number 
of times and Forever block for 
continuous actions.

	 6.	 Yes, we can change backdrops in 
a sequence to create background 
animations.

Assertion Reason Questions
	 1.	 (c)	 2.	 (c)

Source Based Questions
	 1.	 They are one of the eight categories 

of scratch blocks, color-coded light 
blue.

	 2.	 They detect mouse location, sprite 
distance, and touch detection.

	 3.	 There are 18 sensing blocks.

Art Integration
	 Do yourself.
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CHAPTER-8
Artificial Intelligence: 

Introduction

A.	 Tick (3) the correct answer:
	 1.	 (d)	 2.	 (d)	 3.	 (d)
	 4.	 (b)	 5.	 (d)

B.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 3	 3.	 3
	 4.	 3	 5.	 3

D.	 Answer the following questions:
	 1.	 (a) Human Intelligence is a mental 

attribute that includes the capacity 
to learn from experience, adapt 
to new conditions, comprehend 
and handle abstract concepts, and 
manipulate one’s surroundings 
using knowledge.

	 	 (b) Artificial Intelligence is the ability 
of a digital computer or computer-
controlled robot that can perform 
tasks generally associated with 
intelligent beings.

	 2.	 The phrase “Artificial Intelligence” 
was coined by John McCarthy 
(1927–2011), an American computer 
scientist and cognitive scientist. He 
was a pioneer in the field of Artificial 
Intelligence. John McCarthy is 
considered one of the “founding 
fathers” of artificial intelligence.

	 3.	 NITI Aayog is a policy think tank 
of the Government of India that 
promotes economic development. 
It has created a national strategy to 
promote AI for inclusive growth in 
sectors like health, agriculture and 
education.

	 4.	 Artificial Intelligence (AI) is a 
technology that has been around 

since the 1950s. Some markets, 
industries, and businesses are 
further advanced than others, 
because AI is still in its early 
stages of development. There are 
many opportunities for additional 
development and enhancement in 
terms of both the range of possible 
applications and the quality of most 
existing implementations.

	 5.	 Artificial intelligence is needed to 
automate repetitive tasks, improve 
efficiency, solve complex problems, 
and assist in decision making in 
areas like healthcare, education and 
industries.

Assertion Reason Questions
	 1.	 (a)	 2.	 (d)

Source Based Questions
	 1.	 John McCarthy 
	 2.	 Arttificial Intelligence
	 3.	 AI refers to the simulation of 

human intelligence in machines 
programmed to think and act like 
humans.

Art Integration
	 Do yourself.

CHAPTER-9
Animation with TupiTube

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (d)	 3.	 (b)
	 4.	 (c)	 5.	 (a)

B.	 Fill in the blanks :
	 1.	 scenes
	 2.	 frame
	 3.	 drawings
	 4.	 Tween
	 5.	 animation
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C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 3	 3.	 7
	 4.	 7	 5.	 3

D.	 Answer the following questions:
	 1.	 Animation is a set of several drawings 

shown in sequence at high speed to 
create the illusion of movement.

	 2.	 The two ways by which animation 
can be done are: 1. Frame-by-Frame 
animation: Each frame has a unique 
drawing. 2. Tweening: Intermediate 
frames are automatically generated 
between two drawings.

	 3.	 A Motion Tween can be created 
by setting the starting and ending 
positions of a drawing, and the 
software fills in the in-between 
frames.

	 4.	 To save animation: Go to File menu 
> Save options to save your TupiTube 
project.

	 5.	 (a) Frame: A single image in a 
sequence of animation.

	 	 (b) Stage: The main working white 
area in the center. Drawings and 
graphics are created here. It is also 
used to apply animations.

	 	 (c) Stage toolbar: It contains buttons 
to apply some actions on stage such 
as full screen, clear the stage, reset 
stage size, etc.

	 	 (d) Exposure sheet: A sheet that 
organizes the timing of drawings 
and frames in an animation.

Assertion Reason Questions
	 1.	 (a)	 2.	 (d)

Source Based Questions
	 1.	 Animation is a set of several drawings 

kept in a sequence at high speed to 
create the illusion of movement.

	 2.	 Multiple scenes together make up an 
animated story.

	 3.	 Tapi Tube allows you to create 
multiple scenes, each with its own 
frames and layers.

Art Integration
	 Do yourself.

Worksheet
A.	 Tick (3) the correct answer:
	 1.	 (d)	 2.	 (d)	 3.	 (d)
	 4.	 (a)	 5.	 (d)	 6.	 (d)

B.	 Fill in the blanks :
	 1.	 sender
	 2.	 interconnected
	 3.	 Ellipse
	 4.	 internet
	 5.	 18
	 6.	 scenes

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 3	 3.	 3
	 4.	 7	 5.	 7	 6.	 3

D.	 Answer the following questions:
	 1.	 1. Click on the Mailings tab. 2. In 

the Preview Results section, click on 
the Preview Results button to see 
the merged data. 3. Click on Finish 
& Merge. 4. Select Edit Individual 
Documents. 5. In the Merge to Printer 
dialog box, click OK to create a single 
merged document containing all 
recipients' data.

	 2.	 A formula is an equation that 
performs a calculation. Like a 
calculator, Excel can execute 
formulas for addition, subtraction, 
multiplication, and division.
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	 3.	 Five major parts of GIMP window 
are: 1. Toolbox 2. Menu Bar 3. Docks 
or Dialogs Area 4. Canvas or Image 
5. Status Bar

	 4.	 Cloud computing is becoming more 
popular for delivering services over 
both public and private networks. 
The term "cloud" refers to the 
combination of hardware, network, 
storage interfaces, and services that 
deliver various aspects of computing 
as a service over a network.

	 	 The term “cloud” is used here as 
a metaphor for how traditional 
methods of sharing audio, video, and 
photographs have become obsolete 
with the advent of cloud computing.

	 5.	 A variable is a changeable value 
recorded in Scratch’s memory. 
Variables can only hold one value 
at a time. Variables block allows us 

to store data, like scores or timers, 
that can change while the program 
is running.

	 6.	 NITI Aayog is a policy think tank 
of the Government of India that 
promotes economic development. 
It has created a national strategy to 
promote AI for inclusive growth in 
sectors like health, agriculture and 
education.

Assertion Reason Questions
	 1.	 (a)	 2.	 (c)

Source Based Questions
	 1.	 Mohit recently came to know about 

the internet.
	 2.	 The internet offers a variety of 

services that make our work faster 
and easier.

	 3.	 Google, Yahoo! and Bing


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CHAPTER-1
Computers and Computer 

Languages

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (d)	 3.	 (c)
	 4.	 (a)	 5.	 (d)	 6.	 (a)
	 7.	 (b)

B.	 Fill in the blanks :
	 1.	 Software	 2.	 program
	 3.	 system software
	 4.	 operating system
	 5.	 machine

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 7	 2.	 3	 3.	 7
	 4.	 3	 5.	 3

D.	 Match the following:
	 1.	 (d)	 2.	 (e)	 3.	 (c)
	 4.	 (a)	 5.	 (b)

E.	 Answer the following questions:
	 1.	 The different types of computers 

are:
	 	 • Microcomputers
	 	 • Mini Computers
	 	 • Embedded Computers
	 	 • Game Consoles
	 	 • Mainframe Computers
	 	 • Mobile Computers
	 	 • Supercomputers
	 2.	 Software is a collection of programs 

with no physical presence. It is 
stored in digital form within a 
computer’s memory and enables the 

user to interact with the computer 
and perform tasks.

	 	 The various kinds of software are:
	 	 • �System Software (e.g., Operating 

System, Compiler, Assembler)
	 	 • �Application Software (e.g., Word 

Processor, VLC Player)
	 	 • �Utility Software (e.g., Antivirus, 

Disk Cleanup)
	 3.	 Compiler :
	 	 • Takes the entire program in one go.
	 	 • �Generates intermediate machine 

code.
	 	 • �Best suited for production 

environments.
	 	 • �Used in languages like C, C++, 

Java.
	 	 Interpreter :
	 	 • �Takes a single line of code at a time.
	 	 • �Does not generate any intermediate 

code.
	 	 • �Best suited for software 

development.
	 	 • �Used in languages like Python, 

PHP, Ruby.
	 4.	 (a)	 • �Embedded as a chip inside 

another device.
	 	 • �Programmed for specific 

functionality.
	 	 • �Contains all parts of a computer 

(CPU, memory, input/output).
	 	 • �Performs limited, dedicated tasks 

only.
	 	 (b)	• �Fastest among all types of 

computers.
	 	 • �Contains multiple CPUs and GPUs.
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	 	 • �Has very high computing power 
and memory.

	 	 • �Used for scientific, engineering, 
and research applications.

	 	 (c)	 • �Use single-chip processors 
(microprocessors).

	 	 • �Support single user.
	 	 • �Small in size and cost-effective.
	 	 • �Used for learning, games, media 

applications, etc.
	 	 (d)	• �Very powerful with large 

memory and multiple CPUs.
	 	 • �Supports many users and can run 

multiple operating systems.
	 	 • �Used in large organizations for 

critical applications like census or 
data processing.

	 5.	 An assembler is a program that 
converts assembly language (low-
level code using mnemonics) into 
machine code (binary instructions) 
that a computer's CPU can 
understand and execute.

	 6.	 Assembly language was easier than 
first-generation machine language 
because it used mnemonic codes 
(letters and symbols) instead of 
binary digits (0s and 1s), making it 
more readable and easier to program.

	 7.	 Fifth generation languages (5GL) 
are based on problem-solving using 
constraints rather than step-by-step 
algorithms. These languages focus 
on Artificial Intelligence (AI) and are 
designed to work more like human 
reasoning.

	 	 Examples include: Prolog, 
MERCURY, OPSS.

	 	 They are used in AI systems, natural 
language processing, and expert 
systems.

Assertion Reason Questions
	 1.	 (b)	 2.	 (c)

Source Based Questions
	 1.	 Software is a collection of programs 

with no physical presence.
	 2.	 They are stored in digital form within 

computer memory to effectively 
access or operate a computer.

	 3.	 Software is classified into two types:
	 	 (a) System Software
	 	 (b) Application Software

Art Integration
	 Do yourself.

CHAPTER-2
Binary Number System

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (a)	 3.	 (a)
	 4.	 (b)	 5.	 (a)	 6.	 (d)

B.	 Fill in the blanks :
	 1.	 decimal	 2.	 10°
	 3.	 binary	 4.	 base-2
	 5.	 machine language

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 7	 2.	 7	 3.	 3
	 4.	 3	 5.	 3

D.	 Answer the following questions:
	 1.	 A binary number system is one of 

the four types of number systems. 
In computer applications, binary 
numbers are represented by only 
two symbols or digits, i.e. 0 (zero) 
and 1 (one). The binary numbers 
here are expressed in the base-2 
numeral system.

	 2.	 A single binary number is called a 
Binary digit or bit.
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	 3.	 The successive division method is used 
to convert decimal to binary integers. 
In this method, Simply divide the 
decimal number by 2. The quotient 
becomes the dividend. The remainder 
becomes one bit of the binary number, 
least significant digit first.

	 	 Example: 4 in binary = (100)2

	 4.	 Binary numbers are used to represent 
all kinds of data in computers using 
only 0s and 1s. Computers operate 
using machine language, which is 
based on the binary number system.

	 5.	 Using division method:
	 	 163 ÷ 2 = 81 remainder 1
	 	 81 ÷ 2 = 40 remainder 1
	 	 40 ÷ 2 = 20 remainder 0
	 	 20 ÷ 2 = 10 remainder 0
	 	 10 ÷ 2 = 5 remainder 0
	 	 5 ÷ 2 = 2 remainder 1
	 	 2 ÷ 2=1 remainder 0
	 	 1 ÷ 2 = 0 remainder 1
	 	 So, binary of 163 = 10100011.

	 6.	 Using division method:
	 	 200 ÷ 2 = 100 remainder 0
	 	 100 ÷ 2 = 50 remainder 0
	 	 50 ÷ 2 = 25 remainder 0
	 	 25 ÷ 2 = 12 remainder 1
	 	 12 ÷ 2 = 6 remainder 0
	 	 6 ÷ 2 = 3 remainder 0
	 	 3 ÷ 2 = 1 remainder 1
	 	 1 ÷ 2 = 0 remainder 1
	 	 So, binary of 200 = 11001000

Assertion Reason Questions
	 1.	 (e)	 2.	 (a)

Source Based Questions
	 Ashu can use the successive division 

method to convert 6 into binary.

		  6 ÷ 2 = 3, remainder = 0
		  3 ÷ 2=1, remainder = 1
		  1 ÷ 2 = 0, remainder = 1
	 Now writing the remainders in reverse 

order: 110
	 So, the binary of 6 is 110.

Art Integration
	 Do yourself.

CHAPTER-3
Introduction to HTML

A.	 Tick (3) the correct answer:
	 1.	 (c)	 2.	 (d)	 3.	 (c)
	 4.	 (a)	 5.	 (b)	 6.	 (b)

B.	 Fill in the blanks :
	 1.	 <h6>
	 2.	 HTML editor
	 3.	 Hyper Text Markup Language
	 4.	 opening, closing
	 5.	 Chrome, Firefox
	 6.	 forward slash ( / )

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 7	 3.	 3
	 4.	 7	 5.	 7

D.	 Answer the following questions:
	 1.	 HTML or Hypertext Markup 

Language is used for creating web 
pages and web applications. It 
describes the structure of a web page 
and consists of a series of elements 
that tell the browser how to display 
the content.

	 2.	 The tag used for making the text 
bold is <b>.

	 3.	 • �The <b> tag specifies bold text. 
It is a container tag and has an 
opening and closing tag.
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	 	 • �The <br> tag inserts a line break. 
It is an empty tag and does not 
have a closing tag.

	 4.	 HTML headings are defined with 
the <h1> to <h6> tags.

	 	 Example:
	 	 html
	 	 CopyEdit
	 	 <h1>This is the largest heading</h1>

	 	 <h6>This is the smallest heading</h6>

	 5.	 • �A container tag has both an 
opening and a closing tag (e.g., 
<b>... </b>)

	 	 • �An empty tag does not have a 
closing tag (e.g., <br>)

	 6.	 html
	 	 CopyEdit
	 	 <html>
	 	 <head>
	 	 <title>My First HTML Project</title>
	 	 </head>
	 	 <body>
	 	 </body>

	 	 </html>

Assertion Reason Questions
	 1.	 (a)	 2.	 (d)

Source Based Questions
	 1.	 Hyper Text Markup Language
	 2.	 HTML is the standard markup 

language for creating Web pages. 
HTML describes the structure of 
a Web page and consists of a series 
of elements. These elements tell the 
browser how to display the content.

	 3.	 Tim Berners-Lee

Picture Based Questions
	 1.	 Edge, Firefox, Chrome, Safari, Opera
	 2.	 Yes

Art Integration
	 Do yourself.

CHAPTER-4
Website Designing 

Using HTML

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (d)	 3.	 (c)
	 4.	 (a)	 5.	 (b)

B.	 Fill in the blanks :
	 1.	 Comments	 2.	 description list
	 3.	 Ordered	 4.	 href
	 5.	 internal link

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 7	 3.	 7
	 4.	 3	 5.	 7

D.	 Answer the following questions:
	 1.	 The comment tag is used to insert 

comments in the source code. 
Comments are not displayed in the 
browsers. HTML comments are 
visible to anyone that views the page 
source code, but are not rendered 
when the HTML document is 
rendered by a browser.

	 2.	 There are two kinds of links in 
HTML:

	 	 • �External Link: Linked to an 
external web page.

	 	 • �Internal Link: Linked within the 
same web page.

	 3.	 The image can be stored in any 
folder of your computer or it may be 
a link to a webpage.

	 4.	 To insert image in an HTML page, 
use the <img> tag. It is an empty 
tag, containing only attributes.
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	 	 Example:
	 	 html
	 	 CopyEdit
	 	 <img src="example.jpg" alt="A beautiful 

sunset over the mountains" width="400" 
height="300'' style="border: 2px solid 
black;">

	 5.	 The HTML anchor tag defines a 
hyperlink that links one page to 
another page, it can create hyperlink 
to other web page as well as files, 
location, or any URL.

	 6.	 • �An ordered list can be numerical 
or alphabetical. It is used when the 
items must be in a particular order.

	 	 • �A bulleted list is an unordered list. 
It is used when the items are not in 
any particular order.

Assertion Reason Questions
	 1.	 (a)	 2.	 (b)

Source Based Questions
	 To insert an image in an HTML page, 

Sohit should use the <img> tag. It is an 
empty tag and should be placed inside 
the <body> tag.

	 Example:
	 html
	 CopyEdit
	 <img src="example.jpg" alt="A beautiful 

sunset over the mountains" width="400" 
height="300">

Art Integration
	 Do yourself.

CHAPTER-5
Flow Charts and Algorithms

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)	 3.	 (a)
	 4.	 (a)	 5.	 (d)

B.	 Fill in the blanks :
	 1.	 algorithm
	 2.	 computer programmes
	 3.	 flowchart
	 4.	 arrows
	 5.	 man

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 7	 2.	 3	 3.	 3
	 4.	 3	 5.	 7

D.	 Match the following:
	 1.	 (e)	 2.	 (c)	 3.	 (d)
	 4.	 (b)	 5.	 (a)

E.	 Answer the following questions:
	 1.	 An algorithm is simply a set of 

steps used to complete a specific 
task. They're the building blocks for 
programming.

	 2.	 A flowchart is a diagrammatic 
representation of an algorithm, in 
which different steps are shown 
as symbols of different shapes 
connected by arrows.

	 3.	 • �Difficulty in presenting complex 
programs and tasks.

	 	 • �No scope for alteration or 
modification.

	 	 • �Reproduction becomes a problem
	 	 • �It's a time-consuming process.
	 	 • �Difficult to understand for people 

who don't know flowchart 
symbols.

	 	 • �No man to computer 
communication.

	 4.	 Characteristics of a good algorithm 
include:

	 	 • Input	 	 • Output
	 	 • Definiteness	 	 • Effectiveness
	 	 • Termination
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	 5.	 Symbol	 Function
	 	 Oval	 Start or End point
	 	 Arrow	 �Shows direction of 

flow
	 	 Parallelogram	 �Represents input or 

output
	 	 Rectangle	 Represents a 

process
	 	 Diamond	 �Represents a 

decision
	 6.	 • �Mistakes can be easily identified.
	 	 • �Communication becomes effective 

and easy to understand.

Assertion Reason Questions
	 1.	 (a)	 2.	 (b)

Source Based Questions
	 Surbhi should follow these steps:
	 Algorithm:
	 1. START
	 2. Read temperature in Celsius, C
	 3. �Convert to Fahrenheit using F = 9/5 x 

C + 32
	 4. �IF C = 37 THEN PRINT "Body 

temperature is normal" ELSE PRINT 
"Body temperature is not normal"

	 5. STOP
	 Flowchart:
	 •  Start
	 •  Input C
	 •  F = 9/5 x C + 32
	 •  Is C = 37 ?
		   �Yes → Print “Body temperature is 

normal”
		   �No → Print “Body temperature is 

not normal”
	 •  Stop

Art Integration
	 Do yourself.

CHAPTER-6
Future of AI and Rise 

of New Technology

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (a)	 3.	 (a)
	 4.	 (a)	 5.	 (a)

B.	 Fill in the blanks :
	 1.	 Virtual mannequin
	 2.	 Journalists	 3.	 AR, VR
	 4.	 virtual reality
	 5.	 Augmented Reality

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 7	 2.	 3	 3.	 3
	 4.	 3	 5.	 3

D.	 Answer the following questions:
	 1.	 Artificial Intelligence is a machine 

that can solve problems that humans 
perform using natural intelligence.

	 2.	 Augmented Reality (AR) is an 
enhanced version of the real physical 
world that is achieved through the 
use of digital visual elements, sound, 
or other sensory stimuli delivered 
via technology.

	 3.	 Pokemon Go, Snapchat, Google 
Maps.

	 4	 • � AR uses a real-world setting, while 
VR is completely virtual.

	 	 • � AR users can control their 
presence in the real world; VR 
users are controlled by the system

	 	 • � VR requires a headset device, 
but AR can be accessed with a 
smartphone.

	 	 • � AR enhances both the virtual 
and real world while VR only 
enhances a fictional reality.
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	 5.	 AI applications in healthcare can 
change patients’ lives, improving 
diagnostics and treatment, and 
helping patients and the healthcare 
provider make informed medical 
decisions quickly.

	 6.	 • � Turn on and off lights, gadgets, 
and monitor surveillance systems.

	 	 • � Customized schedules like turning 
on coffee machines, lights, fans.

	 	 • � Voice-command smart assistants.
	 	 • � Remote lock control, smoke and 

temperature detection.

Assertion Reason Questions
	 1.	 (c)	 2.	 (c)

Source Based Questions
	 1.	 Virtual Reality is something that 

does not exist physically but can be 
visualised and experienced.

	 2.	 Virtual reality enables the creation 
of real-life simulations in order to 
provide users with an immersive 
experience that makes them feel as if 
they are actually interacting with the 
digital environment around them.

	 3.	 Car racing games.

Picture Based Questions
	 1.	 A smart home voice assistant / AR 

device (such as Amazon Alexa or 
Google Glass).

	 2.	 It performs tasks through voice 
commands such as controlling 
home appliances setting reminders, 
accessing news or media.

Art Integration
	 Artificial Intelligence will transform 

our daily lives by automating homes, 
personalizing services, improving 
healthcare, enhancing transportation, 
and creating smart environments. 
My mural shows robots cleaning 

streets, autonomous vehicles on the 
road, drones delivering packages, and 
homes managed by voice assistants - all 
showing the AI-powered future.

CHAPTER-7
Basic of Python

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (b)	 3.	 (a)
	 4.	 (a)	 5.	 (a)

B.	 Fill in the blanks :
	 1.	 General Public Lincense
	 2.	 interpreted
	 3.	 Guido Van, Rossum
	 4.	 single (') double (''), triple (''' ''')
	 5.	 Prompt

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 3	 3.	 7
	 4.	 3	 5.	 3

D.	 Answer the following questions:
	 1.	 Python is a high-level, interpreted, 

general-purpose programming 
language. Its design philosophy 
emphasizes code readability with 
the use of significant indentation.

	 2.	 • �Python is high-level and open-
source

	 	 • �It is interpreted and case-sensitive
	 	 • �It uses indentation for blocks
	 	 • �It supports multiple paradigms
	 	 • �It has a large standard library
	 	 • �It is portable and platform agnostic
	 3.	 Python is an interpreted language.
	 4.	 Script mode allows writing Python 

code in a file which can be saved and 
executed later.
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	 	 Steps:
	 	 • �Step-1: Open IDLE
	 	 • �Step-2: Click File → New File
	 	 • �Step-3: Write and save file with	

.py extension
	 	 • �Step-4: Run via Run > Run Module
	 5.	 PEP 8 is a set of rules in Python.
	 6.	 The print () function is used to  

display result on screen.

Assertion Reason Questions
	 1.	 (c)	 2.	 (a)

Source Based Questions
	 1.	 Syntax refers to the rules that define 

the structure of a language.
	 2.	 Syntax in computer programming 

means the rules that control 
the structure of the symbols, 
punctuation, and words of a 
programming language.

	 3.	 Syntax errors are mistakes in the 
source code, such as spelling and 
punctuation errors, incorrect labels, 
and so on, which cause an error 
message to be generated by the 
compiler.

Art Integration
	 Understanding variables, data types, 

and syntax is essential to write correct 
Python code.

	 •	� Variables store values and help in 
reusing data.

	 •	� Data Types define the kind of data 
stored (number, string, list, etc.).

	 •	� Syntax ensures proper structure and 
execution of code.

	 My infographic includes icons for:
	 •	 Variables (a name box),
	 •	� Data Types (number, text, list 

symbols),

	 •	� Syntax (error alerts and correct 
format), demonstrating their role in 
building effective Python programs.

CHAPTER-8
More About Python

A.	 Tick (3) the correct answer:
	 1.	 (d)	 2.	 (c)

B.	 Fill in the blanks :
	 1.	 elif	 2.	 Python
	 3.	 else if	 4.	 While
	 5.	 extension

C.	 Answer the following questions:
	 1.	 • �The if statement executes a block of 

code only when a condition is true.
	 	 • �The if...else statement provides an 

alternative block of code when the 
condition is false.

	 2.	 Students should draw a flowchart 
with multiple conditions: if → elif 
→ else, showing different branches 
based on condition checks.

	 3.	 A while loop repeats a block of code 
as long as the condition is true.

	 	 Example:
	 	 python
	 	 CopyEdit
	 	 num = 1
	 	 while num < 5:
	 	     print(num)

	 	     num = num + 1

	 4.	 You get an infinite while loop when 
the condition never becomes false.

	 	 Example:
	 	 python
	 	 CopyEdit
	 	 while True:

	 	     print("This will run forever.")
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Assertion Reason Questions
	 1.	 (a)	 2.	 (c)

Case Based Questions
	 Aman can write a Python program 

using a while loop to print numbers less 
than 20.

	 python
	 CopyEdit
	 num = 1
	 while num < 20:
	     print(num)
	     num = num + 1

Art Integration
	 Reflection : The comic strip can show a 

character named Zara learning Python 
for a school competition. She struggles 
to understand conditions and loops, 
but with practice and examples, she 
learns how to write if, else, and while 
statements. Through trial and error, 
she overcomes her confusion, writes a 
working program, and wins the coding 
contest.

	 Key Lessons: Understanding logic, 
persistence in debugging, and the 
power of structured code with loops 
and conditionals.

CHAPTER-9
Deep Dive into the 

Internet of Things (IoT)

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (b)
	 3.	 (c)	 4.	 (c)
	 5.	 (b)

B.	 Fill in the blanks :
	 1.	 IoT	 2.	 connectivity
	 3.	 Fitbit	 4.	 proximity
	 5.	 healthcare

C.	 True or False :
	 1.	 False	 2.	 True	 3.	 False
	 4.	 False	 5.	 True

D.	 Answer the following questions:
	 1.	 The Internet of Things (IoT) is a 

system of interrelated devices that 
connect to the internet and exchange 
data to perform tasks automatically 
without human involvement.

	 2.	 Fitbit: A wearable device that tracks 
heart rate, steps, and sleep patterns.

	 	 Nest Thermostat: A smart 
thermostat that adjusts temperature 
automatically based on user 
preferences.

	 3.	 A smart thermostat uses sensors to 
monitor temperature and adjust 
settings automatically to save 
energy based on user behaviour and 
preferences.

	 4.	 Data analytics processes and 
analyzes data collected from IoT 
devices to provide insights, detect 
trends, and enable smart decisions.

	 5.	 IoT in smart cities helps manage 
traffic flow, control street lighting, 
monitor air quality, and improve 
public services by collecting and 
analyzing real-time data.

Assertion Reason Questions
	 1.	 (a)	 2.	 (e)

Source Based Questions
	 1.	 IoT sensors monitor soil conditions 

to help optimize the use of water 
and fertilizers.

	 2.	 Wearable devices track a patient’s 
vital signs and alert doctors to any 
abnormalities.

Art Integration
	 Do yourself.
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Worksheet
A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (b)	 3.	 (a)
	 4.	 (a)	 5.	 (a)	 6.	 (b)

B.	 Fill in the blanks :
	 1.	 program	 2.	 binary
	 3.	 internal link
	 4.	 computer programs
	 5.	 virtual reality	 6.	 Python

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 7	 2.	 3	 3.	 7
	 4.	 3	 5.	 3	 6.	 3

D.	 Answer the following questions:
	 1.	 The different types of computers 

are:
	 	 • Microcomputers
	 	 • Mini Computers
	 	 • Embedded Computers
	 	 • Game Consoles
	 	 • Mainframe Computers
	 	 • Mobile Computers
	 	 • Supercomputers
	 2.	 A binary number system is one of 

the four types of number systems. 
In computer applications, binary 
numbers are represented by only 
two symbols or digits, i.e. 0 (zero) 
and 1 (one). The binary numbers 
here are expressed in the base-2 
numeral system.

	 3.	 There are two kinds of links in 
HTML:

	 	 • �External Link: Linked to an 
external web page.

	 	 • �Internal Link: Linked within the 
same web page.

	 4.	 Artificial Intelligence is a machine 
that can solve problems that humans 
perform using natural intelligence.

	 5.	 • �Python is high-level and open-
source

	 	 • �It is interpreted and case-sensitive
	 	 • �It uses indentation for blocks
	 	 • �It supports multiple paradigms
	 	 • �It has a large standard library
	 	 • �It is portable and platform agnostic
	 6.	 • �The if statement executes a block of 

code only when a condition is true.
	 	 • �The if...else statement provides an 

alternative block of code when the 
condition is false.

Assertion Reason Questions
	 1.	 (a)	 2.	 (b)

Source Based Questions
	 1.	 Virtual Reality is something that 

does not exist physically but can be 
visualised and experienced.

	 2.	 Virtual reality enables the creation 
of real-life simulations in order to 
provide users with an immersive 
experience that makes them feel as if 
they are actually interacting with the 
digital environment around them.

	 3.	 Car racing games.

Picture Based Questions
	 1.	 Edge, Firefox, Chrome, Safari, Opera
	 2.	 Yes


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CHAPTER-1
Networking in Computers

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)	 3.	 (a)
	 4.	 (a)	 5.	 (a)	 6.	 (c)

B.	 Fill in the blanks :
	 1.	 standalone	 2.	 bus (cable)
	 3.	 clint-server architecture
	 4.	 bus, star
	 5.	 topology

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 3	 3.	 7
	 4.	 3	 5.	 7

D.	 Answer the following questions:
	 1.	 • �A router is a hardware device used 

to link a LAN with an internet 
connection. It forwards packets 
based on the routing table and 
determines the best path.

	 	 • �A modem enables a computer 
to access the internet using a 
telephone line. It converts digital 
data to analog signals and vice 
versa.

	 2.	 In a client-server architecture, 
the host (server) manages most 
of the resources and services that 
clients request. Clients are typically 
personal computers while servers 
are powerful systems that handle 
tasks like database management.

	 3.	 Bus Topology :
	 	 Advantages: • Requires shorter cable 

length •  Easy to connect computers

	 	 Disadvantages: • If main cable 
breaks, entire network fails 
• Difficult to isolate problems

		  Star Topology :
		  Advantages: • Easy to connect 

computers • Easy to detect faults
		  Disadvantages: • Central point 

failure affects entire network 
• Needs more cables

		  Ring Topology :
		  Advantages: • Faster data transfer
	 	 Disadvantages: • One failure can 

affect the entire network
		  Mesh Topology :
	 	 Advantages: • Multiple communica-

tion paths
		  Disadvantages: • High cost due to 

extensive cabling
	 	 Tree Topology :
		  Advantages: • Easy to identify faulty 

devices • Easily expandable
		  Disadvantages: • Backbone failure 

crashes the segment • Difficult to 
configure

	 4.	 • �Wireless or unguided media 
does not use any physical cables. 
Technologies like Bluetooth and 
Wi-Fi are used for communication 
over short distances.

	 	 • �Bluetooth operates up to 30 feet at 
less than 1 Mbps.

	 	 • �Wi-Fi offers high-speed broadband 
and can span 50–300 feet indoors.

	 5.	 PAN: Personal Area Network
	 	 LAN: Local Area Network
	 	 MAN: Metropolitan Area Network
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Assertion Reason Questions
	 1.	 (c)	 2.	 (a)

Picture Based Questions
	 1.	 It is a router.
	 2.	 It like a LAN with the internet and 

forwards data packets by choosing 
the best path.

	 3.	 It is a Hardware Device.
	 4.	 Reliability: If the server has stopped 

functioning, the network goes down, 
but no other networks are affected 
that are served by the router.

	 	 Security: The information which 
is transmitted to the network will 
traverse the entire cable, but the only 
specified device which has been 
addressed can read the data.

	 	 Performance: Router enhances 
the overall performance of the 
network, by splitting the networks.
Suppose there are 36 workstations 
in a network that generate the same 
amount of traffic. This increases the 
traffic load on the network. Router 
splits the single network into two 
networks of 18 workstations each, 
reducing the traffic load by half.

Art Integration
	 Do yourself.

CHAPTER-2
Computers Crime and Ethics

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)	 3.	 (d)
	 4.	 (a)	 5.	 (b)

B.	 Fill in the blanks :
	 1.	 Computer Ethics	 2.  harm
	 3.	 Cyber bullying	 	 4.  Warms
	 5.	 Spam

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 7	 3.	 7
	 4.	 3	 5.	 7

D.	 Answer the following questions:
	 1.	 Ans. Computer ethics refers to a 

set of guiding principles for using 
computers without causing harm to 
others.

	 2.	 Ans. Cyber bullying or cyber 
harassment is a form of bullying or 
harassment using electronic means. 
It is also known as online bullying.

	 3.	 • �Viruses are malicious programs that 
attach to and corrupt programme 
files.

	 	 • �Trojans are dangerous programs 
that are disguised as useful utilities 
or software and, once installed, 
cause damage to the computer 
system and files.

	 4.	 • �Set up emergency phone numbers 
for immediate dialing.

	 	 • �Maintain strong password and 
pattern protection.

	 	 • �Keep your antivirus and software 
up to date.

	 	 • �Maintain a regular backup of your 
phone's data._,

	 5.	 • �Pharming is a cyber attack 
intended to redirect a website's 
traffic to another, fake site by 
installing a malicious program on 
the computer.  

	 	 • �Phishing is an attack that attempts 
to steal your money, or your 
identity, by getting you to reveal 
personal information such as credit 
card numbers, bank information, 
or passwords on websites that 
pretend to be legitimate.



49Answer Key

	 6.	 • �Children must understand that 
their parents and teachers are 
always available to them in the 
event of a problem.

	 	 • �Children should notify their elders 
about any incident that even 
sounds remotely theratening.

	 	 • �Children should not fear cyber 
bullies as they arc incapable of 
causing harm and can never carry 
out their threats to harm someone.

	 	 • �Children are advised to 
immediately block such intruders 
and never entertain them.

Assertion Reason Questions
	 1.	 (b)	 2.	 (b)

Source Based Questions
	 1.	 Viruses are milicious programs that 

attach to end corrupt programme 
files. 

	 2.	 They corrupt or destroy data storage 
by destroying useful data.

	 3.	 Trojans are dangerous programmes 
that are disguised as useful utilities 
or software and, once installed, cause 
damage to the computer system and 
files.

	 4.	 Worms are programme codes 
that spread their copies across a 
network from one computer to the 
next, slowing down the computers' 
processing.

Case Based Questions
	 1.	 Hacking into someone's social 

networking profile.
	 2.	 She should notify her elders and 

bolck such intruders she should save 
the messeges offline as evidence.

	 3.	 Maintain strong password 
protection, avoid chatting with 

stranger and keep antivirus and 
apps updated.

Art Integration
	 Do yourself.

CHAPTER-3
Attributes in HTML

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)	 3.	 (a)
	 4.	 (a)	 5.	 (a)

B.	 Fill in the blanks :
	 1.	 HTML attribute	 2.  CSS Rule
	 3.	 CSS selectors	 	 4.  id selector
	 5.	 class sector

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 7	 3.	 3
	 4.	 3	 5.	 3

D.	 Answer the following questions:
	 1.	 HTML attributes are pieces of 

markup language used to adjust 
the behavior or display of HTML 
elements.

	 2.	 The Id selector selects one unique 
element using the id attribute. The 
Class selector applies styles to all 
elements having the same class 
name.

	 3.	 A CSS selector is the first part of 
a CSS rule that determines which 
HTML elements the styles should be 
applied to.

	 4.	 • �Element Selector: Selects elements 
by tag name (e.g., p, h1).

	 	 • �Id Selector: Uses #id to select a 
unique element.

	 	 • �Class Selector: Uses .class to select 
multiple elements.
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	 	 • �Universal Selector: Uses * to select 
all elements.

	 	 • �Group Selector: Groups multiple 
selectors with a comma.

	 5.	 Inline Style: Uses the style attribute 
directly in the element.

	 	 Embedded Style Sheet: Styles placed 
inside <style> tags in <head>.

	 	 External Style Sheet: Linked using 
<link> tag to an external .css file.

	 6.	 There are two ways to attach external 
style sheets:

	 	 1. Linking external style sheets:
	 	 By using:
	 	 <link rel="stylesheet" href="style.css"> 

in the <head>.
	 	 2. Importing external style sheets:
	 	 By using:
	 	 import url("style.css") within a <style> 

tag.

Assertion Reason Questions
	 1.	 (b)	 2.	 (b)

Source Based Questions
	 1.	 • �Element Selector  • �Id selector
		  • �Class selector      • �Group selector
		  • �Universal selector
	 2.	 The id attributes of the HTML 

element.

Art Integration
	 Do yourself.

CHAPTER-4
Developing Interactive Webpages

A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (b)	 3.	 (b)
	 4.	 (b)	 5.	 (a)

B.	 Fill in the blanks :
	 1.	 JavaScript	 2.	 script
	 3.	 Values	 4.	 three
	 5.	 Comments

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 7	 3.	 7
	 4.	 3	 5.	 3

D.	 Answer the following questions:
	 1.	 • �Open Notepad
	 	 • �Write JavaScript code inside 

<script> tags
	 	 • �Save file as .html using "Save As" 

and select "All Files"
	 	 • �Double-click the file to open it in a 

web browser
	 2.	 A variable is a holder of a value. It 

can store only one value at a time.
	 3.	 A comment is a non-executable part 

of code used to document or explain 
the code.

	 	 •  Single-line: // comment

	 	 •  Multi-line: /* comment */

	 4.	 Event handling is the process of 
responding to user interactions 
(like click, mouseover) by executing 
functions.

	 5.	 innerHTML refers to the content 
between the opening and closing 
tags of an element. It can be used to 
display or update content on a web 
page.

	 6.	 Use parseint () function
	 	 Example:
	 	 package NumPrograms;
	 	 public class StringToInt1 {
	 	   public static void main(String[] args) {
	 	     String s1 = "2020";
	 	     String s2 = "10";
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	 	     int x = Integer.parseInt(s1);
	 	     int y = Integer.parseInt(s2);

	 	     System.out.println(x);
	 	     System.out.println(y);
	 	   }
	 	 }

Assertion Reason Questions
	 1.	 (c)	 2.	 (a)

Source Based Questions
	 1.	 Values are stored in variables.
	 2.	 One
	 3.	 It is permanently lost.

Art Integration
	 Do yourself.

CHAPTER-5
Database Management 

System

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)	 3.	 (a)
	 4.	 (a)	 5.	 (b)

B.	 Fill in the blanks :
	 1.	 Database	 2.	 DBMS
	 3.	 Data integrity	 4.	 redundancy
	 5.	 relational database

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 7	 3.	 7
	 4.	 7	 5.	 7	 6.	 3

D.	 Answer the following questions:
	 1.	 A DBMS is software that helps users 

create, manage, and manipulate 
databases efficiently. It allows easy 
access, retrieval, updating, and 
management of data.

	 2.	 There are four types of DBMS:

	 	 • �Hierarchical
	 	 • �Network
	 	 • �Object-Oriented
	 	 • �Relational (RDBMS)
	 3.	 • �Column (Attribute): Vertical field 

in a table.
	 	 • �Row (Tuple): Horizontal entry 

representing one record.
	 	 • �Cell: The box where a row and 

column intersect, containing a 
value.

	 	 • �Degree: Number of columns.
	 	 • �Cardinality: Number of rows.
	 4.	 A primary key is a unique identifier 

for each row in a table. It cannot 
have duplicate or null values.

	 5.	 A foreign key is a field in a table that 
refers to the primary key of another 
table. It connects two tables and 
allows relational data.

	 6.	 • �Easy manipulation (add, delete, 
update)

	 	 • �Data security
	 	 • �Data recovery and backup
	 	 • �Data sharing and integrity

Assertion Reason Questions
	 1.	 (a)	 2.	 (c)

Case Based Questions
	 1.	 She should recommend using a 

Database Management System 
(DBMS) like MS Access.

	 2.	 A DBMS will allow easy data storage, 
fast retrieval, reduced errors, backup, 
and secure access.

	 3.	 Yes, a DBMS can benefit all businesses 
by organizing and protecting their 
data.

Picture Based Questions
	 1.	 Microsoft Access
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	 2.	 Creating and managing tables, 
forms, queries, and reports; supports 
relational database functionality.

Art Integration
	 Use boxes for tables and lines or 

arrows to connect related fields. Show 
primary keys and foreign keys using 
color coding or symbols like keys and 
links. This helps visualize how data is 
connected and shared.

CHAPTER-6
MS Access 2019

A.	 Tick (3) the correct answer:
	 1.	 (d)	 2.	 (c)	 3.	 (d)
	 4.	 (b)	 5.	 (a)

B.	 Fill in the blanks :
	 1.	 old data, new one
	 2.	 alphabetically, numerically
	 3.	 Filters	 4.	 Applying
	 5.	 Advanced filter

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 7	 2.	 7	 3.	 3
	 4.	 7	 5.	 3

D.	 Match the following :
	 1.	 (d)	 2.	 (e)	 3.	 (c)
	 4.	 (a)	 5.	 (b)

E.	 Answer the following questions:
	 1.	 Microsoft Access is a Microsoft 

Database Management System 
(DBMS) that combines the relational 
Microsoft Jet Database Engine with a 
graphical user interface and software 
development tools.

	 2.	 1. Ideal for individual users and 
smaller teams. 2. Easier than a 
client-server database to understand 
and use. 3. Access import/export 

functionality for Microsoft Office 
and other applications. 4. Ready 
templates available for everyday 
users to develop and share data. 
5. Allows building and publishing 
Web databases effortlessly. 6. A 
user-friendly feature ‘Tell Me’ for 
assistance. 7. Allows developers 
to create custom solutions using 
VBA code. 8. Hide/Show option 
for Ribbon. 9. Enables users to 
view Reports Eliminates additional 
Reports. 10. Reports can be output in 
PDF format.

	 3.	 First, right-click on the record's row 
header, and then:

	 	 A. �To add a new record, click the 
New Record button.

	 	 B. �To delete a record, click the Delete 
button.

	 4.	 Filters allow you to see only the 
information that you want to see. 
When you create a filter, you specify 
the criteria for the data that will be 
displayed. The filter then searches 
the entire table for records that match 
your search criteria and temporarily 
hides those that don't.

	 5.	 Referential integrity means ensuring 
that correct data is kept in the tables. 
Microsoft Access ensures referential 
integrity in two ways:

	 	 (a) �If the primary key value changes, 
the matching values in the child 
tables will change as well.

	 	 (b) �If a matching record exists in the 
related table, the record in any 
table will not be deleted.

	 6.	 Step-1: Select Relationships from 
the Relationships group under the 
Database Tools tab. The Relationship 
editor will be launched, and the 
Show Table dialogue box will appear.
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	 	 Step-2: In the Show Table dialogue 
box, add the tables Author and Book 
to the Relationship editor one at a 
time, then close the dialogue box.

	 	 Step-3: In the Author table, click 
on the field Author Code (which is 
shared by both tables) and drag it up 
to the same field in the Book table.

	 	 Step-4: The dialogue Edit 
Relationships will appear. Press the 
Create button. The tables will be 
connected.

Assertion Reason Questions
	 1.	 (a)	 2.	 (a)

Source Based Questions
	 1.	 Any value in a child table&#39;s 

foreign key field that is also present 
in the master table.

	 2.	 Referential integrity means ensuring 
the correct data is kept in the tables.

	 3.	 (a) �If the primary key value changes, 
the matching values in the child 
tables will change as well.

	 	 (b) �If a matching record exists in the 
related table, the record in any 
table will not be deleted.

Art Integration
	 Use boxes for tables, rows inside boxes 

for records, and columns for fields. Use 
lines or arrows to show relationships 
between tables.

CHAPTER-7
Turtle Programming 

in Python

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (a)
	 3.	 (d)	 4.	 (a)
	 5.	 (a)

B.	 Fill in the blanks :
	 1.	 turtle	 2.	 different
	 3.	 reset	 4.	 right ( ), left ( )
	 5.	 turtle.forward ( )

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 7	 3.	 3
	 4.	 3	 5.	 7

D.	 Answer the following questions:
	 1.	 Turtle is a pre-installed Python library 

that enables users to create pictures 
and shapes by providing them with 
a virtual canvas. The onscreen pen 
that you use for drawing is called the 
turtle.

	 2.	 Step-1: Click on the Start button.
	 	 Step-2: Scroll the mouse to get 

Python 3.10 option and click on 
IDLE (Python 3.10) to open Python 
IDLE.

	 	 To create a file in Python, in the 
Python Shell, go to the File menu 
and select New File.

	 3.	 The turtle.clone () method is used to 
create and return a clone of the turtle 
with the same position, heading, and 
turtle properties.

	 	 Example: With cloning
# import package
Import turtle
# make first turtle object
tur1=turtle.Turtle ()
# set turtle properties
tur1.width (5)
tur1.color("red")
# move it
tur1.circle (50)
# make another turtle object
tur2=turtle.Turtle ()
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# cloning the properties of
# first turtle object
tur2 = tur1.clone ()
# move it
tur2.circle(-50)

		  Output:

		            
	 4.	 This method is used to stamp a copy 

of the turtle shape onto the canvas 
and return its id.

	 5.	 tur.clear ()

	 6.	 t.bgcolor("red")

	 	 t.fillcolor("yellow")

Assertion Reason Questions
	 1.	 (c)	 2.	 (c)

Source Based Questions
	 1.	 Python provides in build functions 

for creating, writing and reading 
files.

	 2.	 Normal text files and Binary files.
	 3.	 The data is stored after converting it 

into machine-understandable binary 
language.

Art Integration
	 Do yourself.

CHAPTER-8
Code with Python Turtle: 

Control Statements

A.	 Tick (3) the correct answer:
	 1.	 (d)	 2.	 (a)	 3.	 (a)
	 4.	 (a)	 5.	 (a)

B.	 Fill in the blanks :
	 1.	 If	 2.	 if else
	 3.	 Nested if	 4.	 three

	 5.	 while

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 7	 3.	 7
	 4.	 3

D.	 Answer the following questions:
	 1.	 1. If statement 2. If else statement 

3. Nested if statement 4. If... Elif 
ladder 5. Short Hand if statement 
6. Short Hand if-else statement

	 2.	 To handle looping requirements, 
the Python programming language 
provides the following types of loops. 
Loops execute a set of statements 
multiple times based on a condition.

	 3.	 Python provides three methods for 
loop execution: 1. While loop 2. For 
loop 3. Nested loops

	 4.	 Conditional statements are used to 
make decisions based on conditions 
(true/false), while loops are used to 
repeat a block of code as long as a 
condition is true.

	 5.	 While loop: Checks the condition 
before running the loop and 
continues while it's true.

	 	 For loop: Iterates over a sequence 
(like list, range, string) and repeats 
the block for each element.

	 6.	 Indentation refers to the spaces at 
the beginning of a code line. Python 
uses indentation to indicate a block 
of code.

Assertion Reason Questions
	 1.	 (c)	 2.	 (a)

Source Based Questions
	 1.	 Because it determines whether or 

not the code is executed based on 
whether or not it meets the specified 
conditions.
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	 2.	 It contains code that executes only if 
the condition in the 'If statement is 
true.

	 3.	 The statement can be a single line of 
code or an entire block of code.

Art Integration
	 Do yourself.

CHAPTER-9
Al: Challenges and 

Applications

A.	 Tick (3) the correct answer:
	 1.	 (a)	 2.	 (d)	 3.	 (a)
	 4.	 (a)	 5.	 (a)

B.	 Fill in the blanks :
	 1.	 Elucify	 2.	 Reinforcement
	 3.	 Von Neumann's
	 4.	 The Turing Test
	 5.	 Speech Synthesis

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 7	 3.	 3
	 4.	 7	 5.	 3

D.	 Answer the following questions:
	 1.	 The ability of a digital computer 

or computer-controlled robot to 
perform tasks commonly associated 
with intelligent beings is referred to 
as artificial intelligence (AI). The term 
is frequently applied to the project of 
developing systems endowed with 
human-like cognitive processes, 
such as the ability to reason, discover 
meaning, generalise, or learn from 
prior experience.

	 2.	 Eliminate Dull and Boring Tasks: An 
AI system performs assigned tasks 
repeatedly without getting bored.

	 	 Imitates Human Cognition: AI 
mimics the way the human mind 
thinks and solves problems.

	 3.	 Chatbots are software that allows a 
conversation with the user to solve 
any problems they are having, 
either through auditory or texting 
methods. These programs simulate 
human behaviour while conversing 
with a human via an application.

	 4.	 There are four types of AI-based 
systems:

	 	 1. �Reactive Machines – Respond to 
stimuli, no memory.

	 	 2. �Limited Memory – Learn from 
historical data.

	 	 3. �Theory of Mind – Understand 
needs, emotions, and thoughts 
(concept only).

	 	 4. �Self-Aware – Human-like 
intelligence and self-awareness 
(theoretical).

	 5.	 The Turing Test, originally called 
the imitation game, was founded 
by Alan Turing in 1950. It is a test 
of a machine's ability to exhibit 
intelligent behaviour equivalent to, 
or indistinguishable from, that of a 
human.

	 6.	 Recommendation Systems: Used 
in e-commerce and streaming 
platforms to suggest products, 
movies, or music.

	 	 Games: AI systems are developed to 
play and compete in board games 
or video games using planning and 
reinforcement learning.

Assertion Reason Questions
	 1.	 (c)	 2.	 (b)

Source Based Questions
	 1.	 Artificial Intelligence (AI)
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	 2.	 It holds the promise of resolving 
some of society's most pressing 
issues.

	 3.	 Challenges such as incomprehensible 
"black box" algorithms, unethical data 
use, and potential job displacement.

	 4.	 In homes, business, and political 
processes.

Art Integration
	 Do yourself.

Worksheet
A.	 Tick (3) the correct answer:
	 1.	 (b)	 2.	 (a)	 3.	 (a)
	 4.	 (d)	 5.	 (d)	 6.	 (a)

B.	 Fill in the blanks :
	 1.	 Standalone computer
	 2.	 Cyberbullying
	 3.	 attribute
	 4.	 database management system 

(DBMS)
	 5.	 filtered
	 6.	 Speech Synthesis

C.	 Tick (3) the correct statement and 
cross (7) out the wrong one:

	 1.	 3	 2.	 3	 3.	 7
	 4.	 7	 5.	 3	 6.	 7

D.	 Answer the following questions:
	 1.	 A router connects multiple devices 

to a network and manages traffic 
between them. A modem connects 
a network to the internet using the 
ISP’s signal.

	 2.	 • �A virus is a malicious software that 
replicates and spreads by attaching 
itself to files or programs.

	 	 • �A Trojan appears as a useful 
program but actually contains 
harmful code.

	 3.	 • �Open an HTML file.
	 	 • �Use <script> tag.
	 	 • �Write: document.write("Hello 

World");
	 	 • �Save and open in browser to see 

the output.
	 4.	 • �Manages structured data using 

tables. 
	 	 • �Supports forms, queries, and 

reports.
	 	 • �Allows relational database 

management.
	 	 • �Provides GUI for easy data input 

and manipulation.
	 5.	 tur.clear ()

	 6.	 The ability of a digital computer 
or computer-controlled robot to 
perform tasks commonly associated 
with intelligent beings is referred to 
as artificial intelligence (AI). The term 
is frequently applied to the project of 
developing systems endowed with 
human-like cognitive processes, 
such as the ability to reason, discover 
meaning, generalise, or learn from 
prior experience.

Assertion Reason Questions
	 1.	 (a)	 2.	 (a)

Source Based Questions
	 1.	 In variables.
	 2.	 Only one value.
	 3.	 The previous value is permanently 

lost.




